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About this Guide

This section explains the objectives, intended audience, and organization of this publication and
describes the conventions that convey instructions and other information.

This section provides the following information:

Revision History

Document Objectives

Audience

Document Organization

Related Documentation

Document Conventions

Obtaining Optical Networking Information

Obtaining Documentation and Submitting a Service Request

Revision History

Date Notes

December 2010 Updated the “Editing Site Parameters” section in the “Designing Networks with

Cisco MetroPlanner” chapter.

Document Objectives

This <Doc Type> explains how to design networks using the Cisco MetroPlanner design tool for the
Cisco ONS 15454 system. It contains information about how to design an optical network. Use this
<Doc Type> in conjunction with the appropriate publications listed in the Related Documentation
section.
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Audience

This publication is intended for experienced network system engineers who are responsible for planning
and ordering equipment for Cisco optical networking systems.

Document Organization

This Cisco MetroPlanner DWDM Operations Guide, R7.0.1 is organized into the following chapters:

Chapter 1, “Overview” provides a list of features, an overview of the network design process, a
description of the internal architecture, and the Cisco MetroPlanner procedural flow.

Chapter 2, “Designing Networks with Cisco MetroPlanner” provides instructions for using the
Cisco MetroPlanner tool to create a network design, adjust and optimize design components, and
generate reports and bills of materials.

Chapter 3, “Modeled Network Examples” provides examples of typical optical networks that you
can model using Cisco MetroPlanner.

Appendix A, “GUI Information and Shortcuts” provides Cisco MetroPlanner graphical user
interface shortcuts.

Appendix B, “Card Types” provides a list of card types that can be used to build a network, and the
corresponding Cisco product identifier.

Appendix C, “Error Messages” provides a list of system errors.

Appendix D, “Third-Party DWDM Wavelength Interface Model” provides reference information on
third-party DWDM interface calculation.

Related Documentation

Use this Cisco MetroPlanner DWDM Operations Guide, R7.0.1 with the following referenced
publications:

Cisco ONS 15454 DWDM Procedure Guide, R7.0.1—Provides procedures to install, turn up,
provision, and maintain a Cisco ONS 15454 node and network.

Cisco ONS 15454 DWDM Reference Manual, R7.0.1—Provides reference material for Cisco
ONS 15454 nodes and networks.

Cisco ONS 15454 DWDM Troubleshooting Guide, R7.0—Provides general troubleshooting
procedures, and alarm descriptions.

Cisco SONET TL1 Command Guide, R7.0 and Cisco SDH TL1 Command Guide, R7.0.1—Provides
test access TL1 commands, configurations, and parameter types.

Release Notes for the Cisco ONS 15454, R7.0 and Release Notes for the Cisco ONS 15454 SDH,
R7.0.1—Provides caveats, closed issues, and new feature and functionality information.

Document Conventions

This publication uses the following conventions:
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Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ ] Keywords or arguments that appear within square brackets are optional.
{xlxIx} A choice of keywords (represented by x) appears in braces separated by

vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the
Control key while pressing the D key.

screen font Examples of information displayed on the screen.
boldface screen font  Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.

N

Note = Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

A

Caution  Means reader be careful. In this situation, the user might do something that could result in equipment
damage or loss of data.

A

Warning  IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar
with standard practices for preventing accidents. To see translations of the warnings that appear in
this publication, refer to the translated safety warnings that accompanied this device.

Note: SAVE THESE INSTRUCTIONS

Note: This documentation is to be used in conjunction with the specific product installation guide
that shipped with the product. Please refer to the Installation Guide, Configuration Guide, or other
enclosed additional documentation for further details.

Obtaining Optical Networking Information

This section contains information that is specific to optical networking products. For information that
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.
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Where to Find Safety and Warning Information

For safety and warning information, refer to the Cisco Optical Transport Products Safety and
Compliance Information document that accompanied the product. This publication describes the
international agency compliance and safety information for the Cisco ONS 15454 system. It also
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM

Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is
available in a CD-ROM package that ships with your product. The Optical Networking Product
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco MetroPlanner DWDM Operations Guide, R7.0.1
“. April 2006 |


http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

CHAPTER 1

Overview

Cisco MetroPlanner Release 7.0.1 provides a way to model and test wavelength division multiplexing
(WDM) optical networks in a graphical environment. The primary purpose of Cisco MetroPlanner is to
help sales engineers (SEs) design and validate networks of Cisco Optical Networking System (ONS)
15454 Multi-Service Transport Platforms (MSTP). Using Cisco MetroPlanner Release 7.0.1, an SE can
create multiple instances of a network to modify different parameters in each instance for comparison.
Cisco MetroPlanner generates a shelf view of all the sites deployed in the optical network and provides
a complete bill of materials (BOM) for the network and the differences between instances of a network.

This chapter describes how you use Cisco MetroPlanner to design, analyze, and optimize new or existing
Cisco optical networks and contains the following sections:

e 1.1 Cisco MetroPlanner Features, page 1-1

e 1.2 Network Design Process, page 1-2

e 1.3 Cisco MetroPlanner Process Flow, page 1-5

e 1.4 Planning Traffic in Cisco MetroPlanner 7.0.1, page 1-7

e 1.5 Cisco MetroPlanner 7.0.1 Traffic in the Project Explorer Pane, page 1-8
e 1.6 Auto, Forced, and Locked Parameters, page 1-10

1.1 Cisco MetroPlanner Features

Cisco MetroPlanner Release 7.0.1 provides a simple tool set for designing optical networks with Cisco
ONS 15454 MSTP products. You can enter all of the network parameters or minimal information, such
as site distance, and Cisco MetroPlanner will model the network you need to build and generate a
detailed BOM with ordering information. Designing optical networks requires the verification of
multiple constraints such as optical budget limitations and platform architectural restrictions. One
Cisco MetroPlanner project can contain multiple copies of a network. This allows you to change
parameters in one network copy, then analyze and compare to another network copy to determine the
differences. In addition to this capability, Cisco MetroPlanner Release 7.0.1 provides the following new
features:

e Network upgrade to implement forecasted channels
¢ Slot preprovisioning (by importing the NE Update file into the Cisco Transport Controller [CTC]))
e User-defined equipment lists in the parts database

e Fiber separation allowing a user to manage certain parameters (such as loss) for each strand in a fiber
pair
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Forced equipment settings (user-defined parameters instead of Cisco MetroPlanner automatic
settings)

Power consumption calculation

L-band design

C-band enhanced booster

C-band + L-band/50-GHz scalable design

Multishelf management

New DWDM client interfaces

Meshed reconfigurable optical add/drop multiplexing (ROADM)

Capability to select the type of maintenance contract desired to appear in the BOM

1.2 Network Design Process

To generate a network design, the SE enters the following parameters:

The number of network sites

The type of equipment used at each site
The distance separating the sites

The type of fiber connecting the sites

Service demands, including the service type, the protection type, and the number of channels
between nodes

When the network parameters are entered, Cisco MetroPlanner finds the best routing, defines the
required add/drop filters, and places optical amplifiers and dispersion compensation units (DCUs) to fit
the user traffic demands at the minimum cost. Optimization is performed to meet the boundary
conditions. The optimization includes attenuation and amplification.

Finally, Cisco MetroPlanner generates a BOM, which includes the product codes, the quantities, and
pricing information. In addition, it creates other reports, such as a shelf-level view of the configuration,
which can be printed. This helps the SE understand how the shelf is built and helps to avoid confusion
and errors during the actual deployment. Within the BOM is the total network cost, which allows a quick
comparison of various design options. The total network cost is the cost of the equipment for all of the
sites in the designed network.

1.2.1 Network Design Optimization

Cisco MetroPlanner searches for the best solution to a designed network using an optimization
algorithm.

1.2.2 Network Design Constraints

A network design must meet the optical budget and receiver overload criteria to operate efficiently. An
analysis of optical budget and receiver overload evaluates the strength of the signal traversing the ring.
If a design solution satisfies the constraints, it is a valid design. The Cisco MetroPlanner Release 7.0.1
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optimization algorithms generate multiple solutions and verify the constraints against those solutions. If
the constraints are satisfied, the solution with the lowest cost-to-utilization ratio is selected as the
optimal solution.

If the network design solution fails to satisfy all the constraints, Cisco MetroPlanner Release 7.0.1
makes adjustments to parameters such as signal attenuation and amplification. Amplification is achieved
by using an erbium-doped fiber amplifier (EDFA). Attenuation is achieved by using variable optical
attenuator (VOA) modules integrated into the platform. Cisco MetroPlanner Release 7.0.1 corrects the
optical budget using an algorithm that includes automatic placement of EDFAs and VOA regulation.

For each internodal demand, Cisco MetroPlanner Release 7.0.1 performs an optical budget and receiver
overload analysis and displays the results in various reports in the GUI. If the network design algorithms
are not able to provide a solution, then you can modify the input data (for example, by relaxing some
user constraints) and run the analysis again.

1.2.3 Platform Support

Cisco MetroPlanner Release 7.0.1 supports the Cisco ONS 15454 DWDM optical platform Software
Releases 4.7, 5.0.x, and 7.0.x

1.2.4 Topology Support

Cisco MetroPlanner 7.0.1 supports the following network topologies:
e Bus (single span, point-to-point, and linear)
¢ Open (or hubbed) ring
¢ Closed (or meshed) ring
e Any-to-any ring (ROADM)

Cisco MetroPlanner 7.0.1 allows you to design flexible networks with up to 60 site locations. A flexible
network is a network that, using ROADM nodes, allows traffic modification/reconfiguration as traffic
requirements change. The main feature of flexible networks is the traffic reconfiguration/modification
among all the networked nodes or among a subset of them.

The maximum number of locations where the optical service channel (OSC) is terminated is 20. The
maximum number of add/drop locations is 16.

1.2.5 Protection Scheme Support

Cisco MetroPlanner 7.0.1 designs support the following protection schemes:

e Y-cable protected—In Y-cable protection, one transponder card is designated as active and the other
as standby. The standby transponder card has the client-side laser turned off to avoid corrupting the
signal transmitted back to the client. The active transponder monitors the signal from the trunk side
and in the event of loss or signal failure, the system switches to the standby path.

e C(Client-based 14+1—Two client signals are transmitted to separated line cards or transponder cards
instead of using a Y-cable to split one client signal into two line cards or transponder cards. In client
1+1 protection, the failure and switchover is controlled by the client system.
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Fiber-switched protection—The single client signal is injected into the client receive (Rx) port. It is
then split into two separate signals on the two trunk transmit (Tx) ports. The two signals are
transmitted over diverse paths. The far-end card chooses one of the two trunk Rx port signals and
injects it into the Tx client port.

Unprotected—Protection is not used.

1.2.6 Service Support

Cisco MetroPlanner 7.0.1 can support any subset of the following services:

Alien (third-party DWDM interface)
Cisco ONS 15530 2.5 Gbps Aggregated
ONS 15530 10 Gbps Aggregated

ONS 15530 Multirate (MR) Transport
ONS 15530 Data Multiplexer (MXP)

2R Any Rate

Gigabit Ethernet

10GE—10 Gigabit Ethernet (LAN and WAN)
D1 Video

DVB-ASI—Digital Video Broadcast-Asynchronous Serial Interface.
DV-6000

ESCON—Enterprise System Connection
Fast Ethernet

Fibre Channel 1G

Fibre Channel 2G

Fibre Channel 4G

Fibre Channel 10G

FICON—Fiber Connection 1G

FICON Express 2G

High Definition Television (HDTV)
ISC-3 Peer (1G)

ISC-3 Peer (2G)

ISC-3 Peer (2R)

ISC-Compat (ISC-3 Compatibility Mode)
0C-3

0C-12

0C-48

0C-192

OC-768

SDI—Serial Data Input
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STM-1

STM-4

STM-16

STM-64

STM-256

Sysplex CLO—Control Link Oscillator
Sysplex ETR—External Throughput Rate

Note  The Sysplex CLO and Sysplex ETR services are supported only on the following topologies:

Single span—Two terminal sites with 32MUX-O and 32DMX-O cards, or 32WSS and 32DMX or
32DMX-O cards installed and no intermediate sites in between.

Point-to-Point—Two terminal sites with 32MUX-0O and 32DMX-O cards. or 32WSS and 32DMX
or 32DMX-O cards installed. Line amplifiers can be installed between the terminal sites, but
intermediate (traffic terminating) sites cannot be installed.

Two hubs—Two hub nodes in a ring with 32MUX-0O, 32DMX-0, 32WSS, and 32DMX cards or
32DMX-O cards installed. Line amplifiers can be installed between the hubs.

Refer to the Cisco ONS 15454 DWDM Reference Manual for more information about the supported
topologies for the ETR and CLO services.

1.3 Cisco MetroPlanner Process Flow

The following stages are used to complete a network design. See Figure 1-1 for the process flow.

1.
2.

Create a project using the Project Creation wizard.

Create a network using the Create Network wizard. The Create Network wizards adds sites and
places the fiber spans between the sites. A span represents a pair of fibers.

Create a point-to-point, protected ring (P-ring), and/or ROADM service demand.
Analyze the network design.

If you would like to force automatic tool choices, adjust the design and repeat the analysis until you
have reached the desired configuration.

Create an Install copy of the network and update the parameters with real data from the field.
Analyze the Install network.

Create an upgrade copy of the network, as needed, to add forecasted channels.
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Figure 1-1

Cisco MetroPlanner Process Flow
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1.4 Planning Traffic in Cisco MetroPlanner 7.0.1

Traffic in Cisco MetroPlanner is defined as an optical path for each pair of nodes requiring a service
demand. An optical path is the combined channels between the two nodes. The following list gives
definitions for some basic traffic items:

Circuit—A single channel between a pair of source and destination nodes. Depending on the traffic
demand type, the number of circuits can vary from 0 to 32 between a pair of nodes. In addition to
the source and destination nodes and all the attributes that are common to the service containing the
circuit, a circuit has the following attributes:

— Present/forecast indication
- Routing direction for unprotected service
— ITU channel
— Optical bypass indication
Demand—A set of circuits with common characteristics, such as:
- Service demand label
— Number of existing circuits
— Number of forecasted circuits
- Client service type
— Protection type
— Optical bypass (number of channels and/or sites)
— WDM interface type (TXT or ITU-LC)
- WDM card type
— Source client interface (SR, IR, or LR)
— Destination client interface (SR, IR, or LR)

Traffic demand—All traffic between the same set of nodes. Both L-band and C-band are supported.
The following traffic demands are supported: P-ring, Fixed (point-to-point), and Any-to-any
(ROADM).

In P-ring traffic demands, all the demands used to support traffic topologies similar to bidirectional
line switch rings (BLSRs) or multiplex section-shared protection rings (MS-SPRings). Each P-ring
demand is between a pair of added/dropped nodes where BLSR-like (or MS-SPRing-like) traffic

must exist. The number of circuits is the same for each demand, and is user-specified (from 1 to 32).

In fixed (point-to-point) traffic demands, the set of nodes is restricted to two sites. The number of
circuits is user-specified (from 1 to 32).

In any-to-any (ROADM) traffic demands, a minimum of two nodes and a maximum of every node
in the network. An any-to-any traffic demand allows each node to establish one or more circuits with
the other nodes, either as a hub or meshed configuration. In a meshed configuration, each node
defined in the set is connected to each other node. This is the most common traffic type. In a hub
configuration, the user-defined hub node is connected to each of the other nodes. ROADM circuits
have the same protection types and services. The number of circuits is not user-specified and can
vary from 0 to 32. For ROADM, only L-band is supported.

A ROADM demand can have multiple client service types and supports multiple DWDM card
interfaces for each client service type. A ROADM demand supports the following routing strategies:

— Protected (Default)—Each node pair in the traffic demand is connected using two connections.

[ April 2006
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Unprotected optimum optical path—Each node pair is connected using one connection. The
unprotected optimum optical path minimizes the number of required optical amplifiers, but also
restricts the number of channels that can be deployed among the nodes of the traffic demand
(maximum of 32 channels between each node pair) in the installed network.

Unprotected minimum hop count—Each node pair in the traffic demand is connected by one
connection. The unprotected minimum hop count maximizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic demand, but
can requires a higher number of optical amplifiers on the unprotected optimum optical path
(maximum of 32 channels between each node pair) in the installed network.

Unprotected subnet—Each node pair in the traffic demand is connected using one connection.
You can manually force connections on only one branch of the ring. For unprotected subnets,
you must manually select one starting node of the branch and the direction the ring must be
traversed to define the subnet, starting from the initial site. The branch direction is specified by
defining the outgoing side first, referred to as the starting node. This routing strategy option
allows you to exclude some critical paths and (with ROADM traffic demands containing two
sites) to force each ROADM connection clockwise or counterclockwise.

1.5 Cisco MetroPlanner 7.0.1 Traffic in the Project Explorer

Pane

Cisco MetroPlanner 7.0.1 represents all of the user-defined traffic services as a tree view within the
Project Explorer pane. The Project Explorer shows all of the open project information, including the
networks, the network dependencies, sites, fibers, services, etc. (Figure 1-2).

Figure 1-2  Project Explorer View
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After you analyze a network design, the colors of tree view change according to the error/warning
condition of the network design. The icons display as red if there are errors in the network design; orange
if there are warnings but no errors; and green of there are no warnings or errors. The icon shows the color
of the most severe condition. For more information about analyzing the network, see the “2.4 Analyzing
the Network™ section on page 2-37.

Right-clicking on certain items in the Project Explorer tree allows you to edit the parameters. Refer to
Chapter 2, “Designing Networks with Cisco MetroPlanner” for more information about optical results,
the traffic matrix, and editing.

1.5.1 Point-to-Point Traffic Demands

Point-to-point traffic demands appear in the Service Demands > PointToPoint folders in the Project
Explorer pane. Each point-to-point traffic demand is categorized by its source and destination site
names. All of the point-to-point services between the two sites appear under the designated demand
name (Figure 1-3).

Figure 1-3  Point-to-Point Traffic Demand in the Project Explorer
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A point-to-point traffic demand includes the following information:
¢ Client service type

e Site# — Site# (source and destination site labels for this demand)

1.5.2 P-Ring Traffic Demands

Each protected ring (P-ring) traffic demand appears in the Project Explorer pane under the Service
Demands > P-Rings folders. Figure 1-4 shows an example of a P-ring traffic demand in the Project
Explorer.

Figure 1-4  P-Ring Traffic Demand in the Project Explorer
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All the P-ring channels between each site pair are listed under each P-ring traffic demand. Each demand
is labeled with the following information:

¢ P-ring number
¢ Client service type

e Site# — Site# (source and destination site labels for this demand)
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1.5.3 ROADM Traffic Demands

Each ROADM traffic demand appears in the Project Explorer under the Service Demands > ROADMs
folders. The ROADM folder contains each defined ROADM demand. You can define more demands for
the same ROADM for the same set of nodes. Figure 1-5 shows an example of a ROADM traffic demand.

Figure 1-5 ROADM Traffic Demand in the Project Explorer
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In the Project Explorer, each ROADM includes the ROADM demand name and a list of DWDM card
types that support the client service types. Protection types appear in parentheses.

1.6 Auto, Forced, and Locked Parameters

Parameters in Cisco MetroPlanner can be in one of three states:

e Auto—When a user selects Auto for a parameter setting, Cisco MetroPlanner chooses the parameter
value during network analysis. Auto allows the highest degree of flexibility to the
Cisco MetroPlanner in designing a network.

e Forced—The user sets a specific parameter value other than Auto causing Cisco MetroPlanner to
design the network using these constraints. When a setting is forced, the item appears in blue italics
in the Project Explorer pane.

e Locked—The state of a parameter after network analysis. The next Analyzer running cannot change
the value when in the Locked state. A user can unlock an item using the Unlock command. For more
information, see the “2.7.4 Unlocking Parameters in the Network Design” section on page 2-88

Figure 1-6  Locked Sites in the Project Explorer View
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Depending on the initial state, the network analyzer will:
e Move the parameter into the Locked state when the unit or parameter was set to Auto.

e Leave the parameter in the same state if the user forced a specific value for the unit or parameter.
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Cisco MetroPlanner provides you with numerous tools for customizing the software, creating and
analyzing networks, and creating a bill of materials (BoM). You can use Cisco MetroPlanner to perform
the following tasks:

e 2.1 Launching Cisco MetroPlanner, page 2-1

e 2.2 Setting Cisco MetroPlanner Options, page 2-6
e 2.3 Creating a Project, page 2-23

e 2.4 Analyzing the Network, page 2-37

e 2.5 Viewing Network Reports, page 2-37

e 2.6 Editing a Project, page 2-65

e 2.7 Managing the Network Design, page 2-85

e 2.8 Generating a BoM, page 2-89

e 2.9 Managing the Price List, page 2-95

To run Cisco MetroPlanner, you must install the Java 2 Platform, Standard Edition (J2SE), v 1.4.2_04
or 1.5 Java Runtime Environment (JRE). Both are supported, however Cisco recommends that you use
1.5. You can download it from the following URL:

http://java.sun.com/j2se/1.5.0/download.jsp

2.1 Launching Cisco MetroPlanner

~

Note

Step 1

Use the following procedure to launch Cisco MetroPlanner Release 7.01:

Before logging in the first time to Cisco MetroPlanner R7.0, all registered users must get a new
password.

Launch Cisco MetroPlanner by double-clicking the Cisco MetroPlanner R7.0 icon. The
Cisco MetroPlanner 7.0 Login dialog box appears (Figure 2-1).
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Cisco MetroPlanner DWDM Operations Guide, R7.0.1 g


http://java.sun.com/j2se/1.3/download.html

Chapter2  Designing Networks with Cisco MetroPlanner |

I Launching Cisco MetroPlanner

Step 2
Step 3

Step 4

Step 5

Step 6

Figure 2-1 Cisco MetroPlanner 7.0 Login Dialog Box
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Enter your user name in the Login field.
Enter your password in the Password field.

Cisco MetroPlanner provides three chances for you to enter the correct password. The first two times
you enter an incorrect password, Cisco MetroPlanner displays an “Incorrect Password or Login. Please
try again” error message. After a third failed attempt, Cisco MetroPlanner exits with the error message:
“Failed to provide correct password or login, exiting application.”

Check Remember login and password if you want Cisco MetroPlanner to save your user login name
and password.

From the Choose a profile type drop-down list, choose one of the following profiles:
e Network Designer
e Base Network Designer

All of the procedures in the Cisco MetroPlanner DWDM Operations Guide are written for users with
Network Designer access. For more information on profiles and the capabilities they offer, see Table 2-4
on page 2-22.

Click OK to open Cisco MetroPlanner. The login profile type appears in the lower right corner of the
Cisco MetroPlanner window.
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2.1.1 Opening a Project

Step 1

Step 2

Step 3

Use the following procedure to open an existing Cisco MetroPlanner project. To create a new project,
see the “2.3 Creating a Project” section on page 2-23.

Click the project name under Open in the Tasks Pane (Figure 2-2). The project opens. If you do not see
the project name listed, continue with Step 2.

Click Open under Project in the Tasks Pane or in the File menu.

Figure 2-2 Opening a Project from the Tasks Pane
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In the Open Project dialog box, navigate to the desired directory and choose the project. Click Open.
The Cisco MetroPlanner project appears.

2.1.2 Loading and Unloading Networks

Each network in a project requires memory. To save memory, when Cisco MetroPlanner opens a project,
all networks are in the Unloaded state. An unloaded network appears in the Project Explorer with a “U”
next to the network identifier (Figure 2-3). To load an unloaded network, double-click on the network
folder in the Project Explorer, or right-click the network and choose Load from the shortcut menu.
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Figure 2-3 Unloaded Network in the Project Explorer
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A loaded network appears in the Project Explorer with an “L” next to the network identifier (Figure 2-4).
To unload a loaded network, right-click the network icon in the Project Explorer and choose Unload
from the shortcut menu.

Figure 2-4 Loaded Network in the Project Explorer

Project
%] Makes()
= Platfarms
7 Links
B[ Mets

et [L]

151652

2.1.3 Saving a Project

Use the following procedure to save a project:

Step 1 Choose one of the following:

e To save an existing project with the same filename, choose File > Save. You have completed this
procedure.

¢ To save a new project, choose File > Save and go to Step 2.
e To save an existing project with a different filename, choose File > Save As and go to Step 2.

Step2  In the Save Project dialog box, navigate to the desired directory and type the filename. Click Save.
Cisco MetroPlanner saves projects as zipped files with the MPZ extension.

2.1.4 Importing a Cisco MetroPlanner Release 2.5 Project

Use the following procedure to import a Cisco MetroPlanner Release 2.5 project:

Step1  From the File menu, choose Import 2.5.x project.

Step2  In the Open Project dialog box, navigate to the desired directory and choose the project.
Cisco MetroPlanner Release 2.5 projects have a file extension of CMZ.

Step3  Click Open. The Import <R2.5 Project Name> dialog box appears (Figure 2-5).
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Figure 2-5 Import <R2.5 Project Name> Dialog Box
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Step4  Choose one of the following:

e Import only inputs—Choose this option to import all of the Cisco MetroPlanner 2.5x project input
data. The Cisco MetroPlanner 7.0x will define service aggregation, routing of services, amplifiers,
and DCU during network analysis.

e Import outputs as forcings—Choose this option to import all of the Cisco MetroPlanner 2.5x input
and output data with the exception of the optical results and installation parameters. When you run
the network analyzer in Cisco MetroPlanner 7.0x, it does not change the imported output data
parameters; the network analyzer treats these imported values as forced parameters.

Step5 In the Target System Release area, choose the desired release: Release 4.7, Release 5.0, or Release 7.0.
Step6  If you chose Import outputs as forcings, choose the desired outputs to import:

e Import OADM units

e Import Amplifier units and parameter

e Import traffic constraints

e Import client SFP modules

e Generate aggregation groups

Step7  Click OK. The Cisco MetroPlanner Release 2.5 project appears.
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2.1.5 Closing a Project

Use the following procedure to close a Cisco MetroPlanner project:

Step 1 From the File menu, choose Close.
Step2  In the Save Project dialog box, click Yes to save or No to close without saving changes.

Step3  If you clicked Yes and have not previously save the project, the Save Project dialog box appear. Type
the name of the project and click Save. The project closes.

Step 4 To exit Cisco MetroPlanner, choose Exit from the File menu.

2.2 Setting Cisco MetroPlanner Options

Cisco MetroPlanner provides numerous options for customizing the tool and the design.

)

Note  The following procedures for setting options using the Tools menu apply to new projects during project
creation. To change an existing (open) project, click the desired item in the Project Explorer pane
Subnets folder and edit the parameter in the Properties pane.

2.2.1 Setting the Graphical Display

Use the following procedure to set the Cisco MetroPlanner graphical display:

Step1  From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box (Figure 2-6), right-click the Graphic folder and choose Expand from
the shortcut menu.
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Figure 2-6 Options Explorer Dialog Box
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Step 3 To change the color scheme for Cisco MetroPlanner, click Look & Feel and choose the desired scheme
from the drop-down list.
Step4  To change the appearance of the Project Explorer tree, click Project Explorer and complete the
following as needed:
e Alarm Mode—Choose Single for an alarm icon to report only the condition of that item or
Cumulated for an alarm icon to summarize the most critical alarm of the item and its children.
e Bottom Right Icon—(Display only) Displays Locking to indicate that the lock icon appears at the
bottom right of each locked item in the Project Explorer.
¢ Top Right Icon—(Display only) Displays Alarm to indicate that the alarm icon appears at the top
right of each alarmed item in the Project Explorer. The alarm icon will be green, yellow, orange, or
red to indicate the alarm severity.
Step5  To change the NtView <Name> tab appearance, click Network View and complete the following as

needed:
¢ In the Site area, complete the following:

— Color, Selection Color, and Highlight Color—To change the site colors, click in the Color,
Selection Color, and/or Highlight Color fields in the Site list. Click on the drop-down arrow to
display a color swatch popup window. Click the desired color.

— Show Name—Check to display the site name on the NtView <Name> tab.

— Show Amplifiers—Check to display the amplifier icon for a site on the NtView <Name> tab.
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— Show Forced Amplifiers—Check to display the forced amplifier icon for a site on the
NtView Net# tab.

e In the Fiber area, complete the following, as needed. Figure 2-7 shows an example of a duct with all
of the following details shown.

— Color and Selection Color—To change the fiber color, click in the Color and/or Selection Color
fields in the Fibre list and then click on the drop-down arrow.

— Show Spans—Check to display fiber spans on the NtView <Name> tab.

— Show Length—Check to display fiber length on the NtView <Name> tab.

— Show total SOL Loss—Check to display start of life (SOL) loss on the NtView <Name> tab.
- Show total EOL Loss—Check to display end of life (EOL) loss on the NtView <Name> tab.

— Show CD C-band—Check to display C-band chromatic dispersion (CD) on the NtView
<Name> tab.

— Show CD L-band—Check to display L-band chromatic dispersion (CD) on the NtView
<Name> tab.

e To change the color of the traffic demands on the NtView <Name> tab, in the Point To Point,
P-Ring, and Any To Any areas click in the Color and Selection Color fields, and then click on the
drop-down arrow to display a color swatch popup window. Click the desired color.

Figure 2-7 Duct Details Shown on the NtView <Name> Tab

. . Duct Name [1.0Km] SOL[0.25] EOLD.25] CD-C[16.7] C0-L[19.03] - .

BBt = = o e e e e e Site2

151706

Step6  To change the Network Mgmt Tree tab appearance, complete the following as needed:

¢ Inthe Network area, click in the Color and Selection fields. Click on the drop-down arrow to display
a color swatch popup window. Click on the desired color.

¢ In the Link area, complete the following:

— To change the link color, click in the Color field in the Link list and then click on the drop-down
arrow. Choose the desired line width from the drop-down list.

— To change the link appearance, click in the Stroke field in the Link list and then click on the
drop-down arrow. Choose the desired line appearance from the drop-down list.

Step7  Click Ok.

2.2.2 Setting the Default Platform Values

Use the following procedure to establish the default traffic mapping, dense wavelength division
multiplexing (DWDM) design, and default layout settings for a particular platform and system release.
The default settings will appear during project creation.

Step 1 From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box (Figure 2-6 on page 2-7), right-click Platform and choose Expand
from the shortcut menu.
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Step3  Click the desired System Release folder and complete the following as needed:

~

Note  Default changes apply only to the specified system release.

e Band—Choose C-Band or L-Band as the default band.

¢ Scalable C/L—(System Release 7.0 only) Check to set scalable C bands and L bands as the default
setting during project creation. If checked, the design will be scalable to support both C-band and
L-band on the same system.

e Scalable C/50GHz—(System Release 7.0 only) Check to set scalable C-band 50 GHz as the default
setting during project creation. If checked, the design will be scalable to support 50-Ghz channel
spacing in C-band.

Step 4 Click the Restricted List folder. To restrict a card, check the check box in the Restricted column for that
card. To change the setting back to unrestricted, uncheck the check box.

Step5  Click the Traffic Mapping folder and complete the following as needed:

¢ In the General area, choose the desired default setting from the C-Band Rules and/or L-Band Rules
drop-down lists:

— For C-band, the options appear in the following format: C 64Chs 50Ghz(+2dBm/Ch). The
channels available are 64, 32, 16, or 8; the reference per channel power options available are
-1 dBm, 2 dBm, 5 dBm, and 8 dBm; and the spacing options available are 100GHz or S0GHz.

— For L-band, the options appear in the following format: L 32Chs 100Ghz(+5dBm/Ch). The
channels available are 64, 32, 16, or 8; the reference per channel power options available are
-1 dBm, 2 dBm, 5 dBm, and 8 dBm; and the spacing options available are 100GHz or S0GHz.

¢ In the Fixed traffic area, choose the default routing strategy from the drop-down list:
- Auto

— Unprotected optimum optical path—Each node pair is connected using one connection. The
unprotected optimum optical path minimizes the number of required optical amplifiers.

— Unprotected minimum hop count—Each node pair in the traffic group is connected by one
connection. The unprotected minimum hop count minimizes the number of channels (for
unprotected traffic types only) that can be deployed among the nodes of the traffic group.

Step6  Click the DWDM Design Rules folder and complete the following as needed:

e No Tilt Design—Check to force Cisco MetroPlanner to operate the amplifiers inside the gain range
where no tilt is generated. This option sets all the intermediary points of the network so that channels
are always at the reference power level.

a~

Note Long spans (with insertion loss greater than 25dB) might not be supportable.

¢ No In-line Bulk Attenuator Design—Check to design the network without using any inline bulk
attenuators. In case the network cannot be designed without using external in-line attenuators,
Cisco MetroPlanner displays the following error message: “Unfeasible Network design. Site X
should require usage of in-line attenuator. Leave unchecked to allow inline bulk attentuators.”

e No TXT/Line-Card Bulk Attenuator Design—Check to design the network without using any
external receive (Rx) bulk attenuators on transponder or line cards. If any of the clients require Rx
bulk attenuators, then the related channel is shown with the working condition (flagged red, orange,
or yellow). No Rx bulk attenuator will be shown in any of the reports (such as Optical Channel
Results, Internal Connections, or BoM). Leave unchecked to allow bulk attenuators.
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Prevent Use of E-LEAF Dispersion—Check to prevent Cisco MetroPlanner from using E-LEAF
dispersion compensation units (DCUs) on E-LEAF spans for the overall network. Leave unchecked
if you want the algorithm to automatically optimize the usage of the E-LEAF DCUs.

Allow Not Supported Fibers—Check to allow selection of fiber types in a network design that are
not supported by Cisco MetroPlanner. Not all fiber types or combination of fiber types will pass
network analysis. If fiber types selected are not supported, the following error message appears
during network analysis: “Current Design Rules cannot support Fiber Types in the network. Please
contact the Custom Design Team.” If Allow Not Supported Fibers is not checked, Cisco
MetroPlanner does not allow you to select incompatible fiber types during network design.

Step7  To define the shelf configuration parameters, click the Layout folder and complete the following:

Place AIC—Check to instruct Cisco MetroPlanner to put the AIC card in Slot 9 of the first shelf in
each site.

Place FiberStorage—Check to instruct Cisco MetroPlanner to put the fiber storage within the rack
below the optical shelf.

Step8  Click Ok.

Step9  To apply restricted list changes to an open project, complete the following:

Right-click the folder for the network that you want to update and choose Expand from the shortcut
menu.

Right-click the desired platform and release folder under RestrictedEqptListFolder in the Project
Explorer and choose Edit List from the shortcut menu. The Restricted Eqpt list for MSTP 454
DWDM[release 7.0] dialog box appears.

Click Update.
Click Ok to close the dialog box.

2.2.3 Setting the Default Project Values

Use the following procedure to set the default project settings and repair time. These defaults will appear
during project creation.

Step 1 From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box (Figure 2-6 on page 2-7), click Project and complete the following
to set the defaults that appear in the Project Creation wizard:

Customer—Enter the default customer name (128 character maximum).
Created by—Enter the default user name (128 character maximum).

Units—Choose the desired default span length unit of measure from the drop-down list, either Km
or Miles.

Price List—Choose the desired default price list.

Layout—Choose either ANSI (American National Standards Institute) or ETSI (European
Telecommunications Standards Institute) from the drop-down list.

Step3  Click General and complete the following:
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MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This will apply
to every site in the network. If you change the MTTR value after creating sites, the new value will
only apply to sites you create after the change.

Restocking Time (days)—Enter the number of days required (including transportation time) to
restock the units into the maintenance center.

Confidence Level (%)—Choose the confidence level for finding the spare units in the maintenance
center (50, 75, 95, or 99 percent).

Stepd  Click Ok.

2.2.4 Setting the Fiber Type Default Values

Use the following procedure to set the fiber type default values. The changes do not apply to the current
project. After setting the values for the fiber types, you must export the database changes to a file and
then import the file. For more information, see the “2.2.6 Exporting a File” section on page 2-17 and
the “2.2.7 Importing a File” section on page 2-18.

Step 1 From the Tools menu, choose Options.

Step2  In the Options Explorer dialog box, click Fiber.

Step3  To modify the default values, complete the following as needed:

Span Label Tag—Type the desired span label; the default label is Duct.

Span Length—Type the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

EOL Ageing loss [dB]—Type the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

EOL Ageing Factor—Type the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

~

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields.

Connector loss [dB]—Type the concentrated loss at the end of the span.

Length Based Loss—If checked, the fiber loss is determined by Span Length * Loss Factor. If the
check box is not checked, you must enter the total loss of the span.

Tot SOL loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length. In the Length Based model, this value is calculated automatically.

Step4  Click Ok.
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2.2.5 Defining Third-Party DWDM Interfaces

Note

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6

Step 7

Cisco MetroPlanner allows you to define a third-party DWDM interface to be used in project creation.
Once you define third-party DWDM interfaces, you can choose them when creating traffic demands. For
more information on defining third-party interfaces, see Appendix D, “Third-Party DWDM Wavelength
Interface Model.”

If you create a network design with a third-party interface and need to share the design with other users,
you must provide not only the saved network MPZ file but also the exported database file containing the
third-party interface definition. To view this project, the other user first must import the database with
the third-party interface values.

Use the following procedure to define a third-party DWDM interface:

Click Tools > DB Parts Mgmt. The DB Parts Manager dialog box appears.

a~

Note  You cannot open the DB Parts Manager if a project is open.

Right-click Platform Parts and choose Expand from the shortcut menu.

Right-click Group and choose New Group from the shortcut menu. The new group appears under
Group and in each system release under parts DB.

In the Group Editor dialog box, complete the following:
e Name of group—Enter the name of the new database.
e Version of group—Displays 1.0 to indicate that this is the first version of the group.
e Owner—Enter the group owner name.
e Note—(Optional) Enter a description of the group.
In the parts DB for the desired system release, click the group that you created.

In the Parts tab of the DB Parts Manager dialog box, right-click and choose Client and then Alien from
the shortcut menu. A new row appears on the Parts tab for the client hardware.

Double-click the row to open the Alien dialog box (Figure 2-8).
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Figure 2-8 Alien Card Dialog Box
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In the General tab of the Alien dialog box, type the name of the card in the Name field.

Click the Istance tab and complete the following:

Ansi PID—Enter the product identifier of the ANSI system, as needed. If you select BoM visible
for this third-party interface with ANSI PID completed, the third-party interface is included in the
BoM with the related product identifier.

Etsi PID—Enter the product identifier of the ETSI system, as needed. If you select BoM visible for
this third-party interface with ETSI PID completed, the third-party interface is included in the BoM
with the related product identifier.

TAG—(Display only) For internal use.
SYS. NAME ANSI—Not applicable for third-party interfaces.
SYS. NAME ETSI—Not applicable for third-party interfaces.

WL START—Choose the wavelength starting range that the third-party interface supports from the
drop-down menu.

WL END—Choose the wavelength ending range that the third-party interface supports from the
drop-down menu.

Click the Physical Ports tab and in the Label column, type a label for each port.

The CTC Ports and TL1 Ports tabs are not applicable for third-party interfaces.
Click Ok.

In the Parts tab of the DB Parts Manager dialog box, right-click and choose Software and then Alien
from the shortcut menu. A new row appears on the Parts tab for the client software.

Double-click the row to open the AlienSoft dialog box.

In the General tab, complete the following:

[ December 2010

Cisco MetroPlanner DWDM Operations Guide, R7.0.1 g



Chapter2  Designing Networks with Cisco MetroPlanner |

M Setting Cisco MetroPlanner Options

e Name—Type the name in the Name field.
¢ Related Item—Choose the client card that you created in Steps 7 to 11.
Step15 Click the Default - OCh tab (Figure 2-9).

Figure 2-9 Alien Software Dialog Box
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Step16 Complete the following (see Tables 2-1 through 2-3 for supported value combinations):
¢ In the Rules area, choose the C- or L-band design rule from the Design Rule drop-down list.
¢ In the Technology Area, complete the following:
— Modulation Format—Choose NRZ (Non Return to Zero) or Duo Binary.

— Transmitter Type—Choose MZ (Mach Zehnder), DML (Direct Modulated Laser) or
EML (Electro-absorption Modulated Laser).

- Receiver Threshold—Choose Optimal (minimum BER) or Average (average received power).
— Regeneration Type—Choose 3R or 2R regeneration mode.
- FEC Mode—Choose FEC (Forward Error Correction), no FEC, or E-FEC (Enhanced FEC).

— Transmitter Stability—Choose the maximum wavelength error allowed (pm). The values are
12.5, 25, 50, or 100 pm.

¢ Bit Rate—Choose the desired bit rate from the drop-down list.
¢ In the TX Power Range area, complete the following:

- TX Max Power—Enter the maximum power output level (dBm).
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— TX Min Power—Enter the minimum power output level (dBm).

In the Back to Back Receiver Sensitivity area, complete the following as needed to define the
working interface area for Back to Back. Back to Back is a configuration where the receiver is
placed in front of the transmitter and no other equipment exists between the two. Back to Back is
used to measure characteristics of the TX and RX pair. Figure 2-10 shows the interface operative
area.

— Overload Power [dBm]—Enter the overload power level.

— OL_Power [dBm]—Enter the minimum power level in the Optical Signal-to-Noise Ratio
(OSNR)-limited range.

— OL_OSNR [dB] on 0.5 nm RBW—Enter the minimum OSNR level in the OSNR-limited range
(measured in .5 increments).

— PL_Power [dBm]—Enter the minimum power level in the power-limited range.

— PL_OSNR [dB] on 0.5 nm RBW—Enter the minimum power level in the OSNL-limited range
(measured on 0.5 nm bandwidth).

In the Chromatic Dispersion area, complete the following as needed:

— Customize CD Robustness—Check to enable the CD Robustness field, as needed. Chromatic
dispersion (CD) refers to the broadening of a light pulse after traveling a distance in the fiber.

— CD Robustness [ps/(nm*km)]—If Customize CD Robustness is checked, choose the maximum
positive dispersion, Dmax_pos [ps/(nm*km)], tolerable by the interface: 0dB, 1dB, 1.5dB, 2dB,
or 3dB.

Customize Penalties—Check to enable the Gaussian Cross-Talk Penalties, Single-Interfering
Cross-Talk Penalties, and Scale Q factors fields as needed.

If Customize Penalties is checked, enter the values to determine the Gaussian Cross-Talk Penalties
in the A_GXt and B_GXct fields, as needed. Gaussion cross talk refers to random power that
interferes with a signal. The A_GXt and B_GXt values are the coefficients for the exponential
curves that estimate P-penalty(PL), P-penalty(OL), OSNR-penalty(PL), and OSNR-penalty(OL) for
Gaussion cross-talk levels in the OL and PL regions of the interface model with dispersion margins
added (see Figure 2-10). The formula is Penalty(GXt) = A_GXt * exp(B_GXt *GXt).

If Customize Penalties is checked, enter the values to determine the Single-Interfering Cross-Talk
Penalties in the A_SIXt and B_SIXt fields, as needed. Single-interfering cross talk refers to
interference caused by a single signal. The A_SIXt and B_SIXt values are the coefficients for the
exponential curves that estimate P-penalty(PL), P-penalty(OL), OSNR-penalty(PL), and
OSNR-penalty(OL) for single-interfering cross-talk in the OL and PL regions of the interface model
with dispersion margins added (see Figure 2-10). The formula is Penalty(IXt) = A_SIXt*
exp(B_SIXt* IXt).

If Customize Penalties is checked, enter Scale Q values in the F-P(PL), F-P(OL), F-OSNR(PL), and
F-OSNR(OL) fields, as needed. The scale factors measure how efficient a card is in recovering the
signal distortion. The slope of the Q-factor curve versus OSNR or RX power determines how a BER
increase could be recovered with an increase of OSNR, power, or both (depending in which
OSNR/power working point the card is). In general, the scale factors are two values (one in OSNR
and one in power) for each working point OL and PL of the interface model (see Figure 2-10). The
the F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values translate a Q-penalty (that is, a BER
increase) into power and OSNR penalties. The formulas follow:

— P-penalty(PL) = Q-penalty * F-P(PL)
— P-penalty(OL) = Q-penalty * F-P(OL)
— OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)
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— OSNR-penalty(OL) = Q-penalty * F-OSNR(OL)

F-P(PL) and F-OSNR(PL) are evaluated in the PL working region, while F-P(OL) and F-OSNR(OL)
are evaluated in the OL working region of the curve with the dispersion margins added.

Figure 2-10 Interface Operative Area
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Table 2-1 lists the supported combinations for 40-Gbs third party interfaces.
Table 2-1  Supported Combination for 40-Gbs Third-Party Interface
> Chromatic Dispersion Penalties [dBm]
Modulation RX Stability | P-penalty OSNR- OSNR-
Format TX Type Threshold |FEC [pm] (oL) penalty(OL) |P-penalty(PL) |penalty(PL)
Duo Binary |MZ Optimal E-FEC +12 0 1 0 1

Table 2-2 lists the supported combinations for 10-Gbs third party interfaces.
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Table 2-2 Supported Combinations for 10-Gbs Third-Party Interface

™ Chromatic Dispersion Penalties [dBm]
Modulation RX Stability | P-penalty OSNR- OSNR-
Format TX Type Threshold |FEC [pm] (oL) penalty(OL) |P-penalty(PL) |penalty(PL)
NRZ MZ Optimal E-FEC +25 0 2 1 0
NRZ MZ Optimal FEC +25 0 1.5 1 0
NRZ MZ Average no FEC +25 2 0 2 0
NRZ EML Average no FEC + 100 0 3 3 0

Table 2-3 lists the supported combinations for 2.5-Gbs third party interfaces.

Table 2-3 Supported Combinations for 2.5-Gbs Third-Party Interface

> Chromatic Dispersion Penalties [dBm]

Modulation RX Stability |P-penalty OSNR- OSNR-
Format TX Type Threshold |FEC [pm] (OL) penalty(OL) |P-penalty(PL) |penalty(PL)
NRZ DML Average FEC +25 0 2 2 0

NRZ DML Average no FEC +25 0 2 2 0

NRZ DML Average no FEC +25 3 0 3 0

NRZ DML Average no FEC +25 3 3 3 3

NRZ EML Average no FEC +25 0 2 2 0

NRZ DML Average no FEC + 100 0 3 3 0

Step17 Click Ok.

2.2.6 Exporting a File

Use the following procedure to export user options, price lists, maintenance contracts, and the parts
database files. The Export command creates a ZIP file that includes all of the created files.

Step 1 From the Tools menu, choose Export. The Export dialog box appears (Figure 2-11).
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Figure 2-11 Export Dialog Box
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Step2  In the Export dialog box, enter a file path and name in the file name field. To export to an existing file,
click the ... button and navigate to the desired directory and file. Click Select to choose the file.

Step3  To select the items to export, complete the following as needed:
e User Option—Check to export the user options set using the Tools > Options command.
e PartsDB—Check the desired platforms.

e PriceDB—Check All Price DB to export all price lists, or expand All Price DB and check the
individual price lists that you want to export.

Step4  Click Ok.

2.2.7 Importing a File

Use the following procedure to import user options, price lists, maintenance contracts, and the parts
database files. You can import a ZIP file of multiple exported items or an individual TXT file.

Step1  From the Tools menu, choose Import. The Import dialog box appears (Figure 2-12).
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Figure 2-12 Import Dialog Box
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In the Import dialog box, click the ... button and navigate to the desired directory and file. Click Select
to choose the file to import.

Click load.

If you selected a single TXT file, skip this step and go to Step 5. If you selected a ZIP file with multiple
exported options, complete the following as needed:

e User Option—Leave checked to import a file with the user options that were set with the Tools >
Options command.

e PartsDB—Leave checked to import the parts database for the desired platform.

e PriceDB—Leave All Price DB checked to import all price lists, or uncheck and check the desired
individual price lists.

Click Ok.

In the confirmation dialog box, click Ok.

2.2.8 Resetting the Default Layout

Your graphical layout settings are saved when you exit Cisco MetroPlanner. The next time that you
launch Cisco MetroPlanner, the layout appears as it did upon exiting. The default graphical layout
includes items such as whether the panes are visible and/or docked, etc.

To return to the Cisco MetroPlanner default layout, choose Default Layout from the View menu. To
restore the user modified layout, choose My Default View from the View menu.
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2.2.9 Adding Plug-ins

Use the following procedure to add plug-ins to Cisco MetroPlanner. Plug-ins are released separately
from Cisco MetroPlanner by Cisco Systems. Using plug-ins, you can customize the released version of
Cisco MetroPlanner.

Step 1 Copy the plug-in file into the Documents and Settings\username\Desktop\MP7\plugins folder.
Step2  From the File menu, choose Exit, then click Yes or No to save the existing project.

Step 3 Launch Cisco MetroPlanner. For more information, see the “2.1 Launching Cisco MetroPlanner”
section on page 2-1.

Step4  Choose Tools > Plug-In > View Plugin registry. The Plugln Registry dialog box appears (Figure 2-13).

Figure 2-13 Plugin Registry Dialog Box
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Step5  In the Plugln Tree, right-click the new plug-in folder and choose Expand from the shortcut menu.
Step6  Right-click the new plug-in and choose Run at start from the shortcut menu.

Step7  Click OKk.

Step8  In the confirmation dialog box, click Ok.

Step9  Close Cisco MetroPlanner and restart. The new plug-in appears as a command under the File menu.
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2.2.10 Managing Plug-ins

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6
Step 7

Use the following procedure to view and manage plug-ins. For information about adding plug-ins, see
“2.2.9 Adding Plug-ins” section on page 2-20.

Choose Tools > Plug-In > View Plugin registry. The Plugln Registry dialog box appears (Figure 2-13
on page 2-20).

In the Plugln Tree, right-click the plug-in folder and choose Expand from the shortcut menu.

Click a plug-in to view information about it. The right pane of the Plugln Registry dialog box displays
the plug-in information.

e The General area of the Plugln Registry dialog box identifies the following information:
— Name—(Display only) Displays the name of the plug-in.
— Path—(Display only) Displays the location of the plug-in.
— Version—(Display only) Displays the version of the plug-in.
— Provider—Displays the name of the supplier of the plug-in.
- Text—(Display only) Displays a brief description of the plug-in.

— Exclusion—(Display only) Displays the exclusion label. The exclusion attribute is a tag that
defines an exclusion rule for a plugin. No more that one plugin with a given exclusion tag can
be run at the same time.

e The State area of the Plugln Registry dialog box identifies the plug-in current state and restrictions:
— Current State—(Display only) Identifies the state of the plug-in.

— Can be stopped—(Display only) If True, you can disable the plug-in during the current session
of Cisco MetroPlanner. The plug-in will disappear from the File menu. To restart a plug-in that
has been stopped, you must exit and relaunch Cisco MetroPlanner. If False, you cannot stop the
plug-in during an active Cisco MetroPlanner session.

— Can be suspend—(Display only) If True, you can disable the plug-in during the current session
of Cisco MetroPlanner. The plug-in will disappear from the File menu. To restart a plug-in that
has been suspended, you can choose Resume in the Plugln Registry dialog box. It is not
necessary to exit and relaunch Cisco MetroPlanner. If False, you cannot suspend and resume
this plug-in during an active Cisco MetroPlanner session.

e The Run Information area of the Plugln Registry dialog box displays the Can be deactivated state.
If True, you can deactivate a plug-in but must exit and relaunch Cisco MetroPlanner for the
deactivation to take effect. When you relaunch Cisco MetroPlanner, the plug-in will not appear in
the File menu. If False, you cannot deactivate this plug-in.

To disable or suspend a plug-in, right-click the plug-in and choose one of the following from the shortcut
menu:

¢ Do not run at start—Choose to disable the plug-in the next time Cisco MetroPlanner is launched.

¢ Suspend/Resume—Choose Suspend if you want to disable the plug-in immediately without
restarting Cisco MetroPlanner. Choose Resume to enable a suspended plug-in.

Click Ok.
In the confirmation dialog box, click Ok.

If you chose Do not run at start, exit and relaunch Cisco MetroPlanner for the plug-in to be disabled.
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2.2.11 Adding User Profiles

Step 1
Step 2

A user profile is a set of privileges used for running Cisco MetroPlanner. Each profile offers different
capabilities. Cisco MetroPlanner is packaged with the Network Designer and Base Network Designer
profiles, but you can add other user profile types provided by Cisco Systems. All of the procedures in
the Cisco MetroPlanner DWDM Operations Guide are written for users with Network Designer access.

Table 2-4 lists the privileges that differ between the Network Designer and the Base Network Designer
user profiles. For all other commands and options, the two user profiles have the same privileges.

Table 2-4  Different Privileges for Network Designer and Base Network Designer

Cisco MetroPlanner Command/Option Network Designer Base Network Designer
Tools > Parts Database > New group Yes No

Tools > View Plug-in registry Yes Yes

Tools > Options > Platform Options > Restricted | Yes Read only

Equipment list

Tools > Price List Mgmt > Master Price Database |Yes Read only

Tools > Export Yes Yes

Tools > Import Yes Yes

Use the following procedure to add a user profile to Cisco MetroPlanner:

Copy the profile JAR file into the Documents and Settings\username\Desktop\MP7\profiles folder.

Launch Cisco MetroPlanner. For more information, see the “2.1 Launching Cisco MetroPlanner”
section on page 2-1. The new profile should appear in the Choose a profile type drop-down list.

2.2.12 Running a Script

Note

Step 1
Step 2
Step 3

Use the following procedure to run a script. A script is a sequence of commands in a BSH file format
that is used to provide additional Cisco MetroPlanner capabilities. Cisco Systems provides valid scripts
to help you customize your Cisco MetroPlanner software.

You must have received a valid script from Cisco Systems before you can perform this procedure.

From the Script menu, choose Run Script.
In the Choose the script to run dialog box, click the desired script and click Open. The script runs.

To run a script again, choose Run Again > script name.
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2.2.13 Refreshing the Script Menu

Common scripts, located in the Cisco MetroPlanner scripts directory, display in the Script > Common
menu and can be run by any user. User scripts, located in the C:/Documents And
Settings/<user-home>/MP_<version>/scripts, display in the Script > User menu.

Any time you add or remove a script from one of these directories, you must choose Refresh Dirs so
that the changes appear on the Script menu. The Remove Dirs command removes script names from the
Script > Run Again menu and updates the Script > Common and User menus.

2.3 Creating a Project

A project consists of a single network or multiple networks that you analyze and compare. In a project,
you can have multiple copies of a single network with the same customer input data, but use different
options in each to investigate multiple solutions.

Use the following procedure to create a single network in a project. A new network is in the Design state.
For more information about the different network states, see the “2.7 Managing the Network Design”
section on page 2-85.

Step 1 From the File menu, choose New. The Project Creation Wizard appears (Figure 2-14).
Figure 2-14 Project Creation Wizard
Project Creation Wizard ' x|
Steps: Project Paramneters
1. Project
Created By IUser|
2. Platfarm Custamer Mame I
Metwork Platform Layout ENSI - I
3, Release Span Measurement Lnits Em = I
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4. Subnet
5. Finish
=Back Mexk = Fimish | Cancel | E
o
Step2  On the Project page, complete the following:
¢ Created By—Displays the user login name. You can edit this field (128 character maximum).
Cisco MetroPlanner DWDM Operations Guide, R7.0.1
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Step 3
Step 4
Step 5

Step 6

Customer Name—Type the name of the customer (128 character maximum) requiring this network
design.

Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI)
service demands.

Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit
of measure used for span length.

Price List—Choose the price list from the drop-down list.

Click Next.

On the Platform page, check the desired platform and click Next.

On the Release page, check the desired software release for the network design and click Next. The
default is the latest release. This attribute defines the list of hardware parts that cannot be used in the
design because they are not supported by a particular release.

On the Subnet page, complete the following (Figure 2-15):

Traffic mapping—Check to select the ONS 15454 Release 7.0 version of the interface and
wavelength routing optimization algorithm to be used in the network design. Release 7.0 is
backward compatible and can manage Software Release 4.7, 5.0, and 7.0.

Metro Core—Check to select the ONS 15454 Release 7.0 version of the algorithm used to optimize
the amplifier and DCU placement within the subnetwork. Release 7.0 is backward compatible and
can manage Software Release 4.7, 5.0, and 7.0.

Layout—Check to define the ONS 15454 Release 7.0 version of the algorithm used to generate the
layout of each site within the subnetwork. Release 7.0 is backward compatible and can manage
Software Release 4.7, 5.0, and 7.0.

Bands—Choose C-Band or L-Band. L-Band is available only for Release 7.0 networks.

Scalable C/L Bands—Choose Yes or No to specify if the design will be scalable to support both
C-band and L-band on the same system. This option is available only for Release 7.0 networks and
if C-Band is selected.

Scalable C-band/50GHz—Choose Yes or No to specify if the design will be scalable to support
50-Ghz channel spacing in C-band. This option is available only for Release 7.0 networks and if
C-Band is selected.

C-band Rules—Choose the option that will be the maximum per-channel power and channel spacing
for the network design. This option is available when the selected band is C-band. For C-band, the
options appear in the following format: C 64Chs 50Ghz(+2dBm/Ch). The channels available are 64,
32, 16, or 8; the reference per channel power options available are -1 dBm, 2 dBm, 5 dBm, and 8
dBm; and the spacing options available are 100GHz or 50GHz.

L-band Rules—Choose the option that will be the maximum per-channel power and channel spacing
for the network design. This option is available when the selected band is L-band. For L-band, the
options appear in the following format: L 32Chs 100Ghz(+5dBm/Ch). The channels available are
64, 32, 16, or 8; the reference per channel power options available are -1 dBm, 2 dBm, 5 dBm, and
8 dBm; and the spacing options available are 100GHz or 50GHz.
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Figure 2-15 Project Creation Wizard Subnet Page
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Step7  Click Next.

Step8  Complete one of the following:

e To run the Network Creation wizard, check the Run the Network Wizard Now check box and click
Finish. Continue with Step 9.

e To create an empty project to add sites and fibers manually, uncheck the Run the Network Wizard
Now check box and click Finish. Project Wizard creates the project and an empty network and
subnetwork under which you can manually add sites and fibers. Skip the remaining steps in this
procedure. To add sites manually, see the “2.3.1 Adding Sites” section on page 2-29.

Step9  In the Topology page of the Network Creation wizard (Figure 2-16), choose Ring or Linear from the
Topologies drop-down list and click Next.
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Figure 2-16 Network Creation Wizard Topology Page
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Step10 On the Configuration page, enter the number of sites in the Site number field and click Next. The
maximum number of sites per network design is 60 sites and the default is 3 sites.

Step11  On the Site Management page, complete the following (Figure 2-17):

Shelf Management—Choose the shelf management configuration:

— Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards

(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this
option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to support the multishelf
configuration.

Multi Shelf External Switch—All the MSTP optical card (OADMs and amplifiers) reside in
different shelves connected by a LAN. The LAN is implemented with switches external to the
MSTP shelves (Cisco Catalyst 2950). For this option, two external Ethernet switch units are
used to support the multishelf configuration.

Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same
shelf. For this option, multishelf management is not supported; every shelf is managed as an
independent shelf.

e Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves
(multishelf configurations). Same Shelf configuration places all the OADM/ROADM units in a
single shelf, and does not provide any protection at the shelf level in the node. Separated Shelves
places OADM/ROADM units west- and east-facing in separate shelves in the node and it is
selectable only if Multishelf management is selected.

e Hybrid Node—Check to create all the nodes configured as hybrid MSTP/Multi Service Provisioning
Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf as the Shelf

Management type.
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Osmine Compliant—Check this option to place the DWDM units in the shelves according to
Operations Systems Modifications of Intelligent Network Elements (OSMINE) placement rules.

DCC chain—Check to put a TXP(P)_MR_2.5G card in Slot 12 on each shelf of each site to use
DCC.

Max Shelf Num—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves (equipping
optical cards or TXP/MXP card) that can be placed in each rack in the site when generating the
layout of the site.

Figure 2-17 Network Creation Wizard Site Management Page
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Click Next.

In the Span Parameters, complete the following (Figure 2-18):

Span Label Tag—Type the desired span label.
Span Fibre Type—Choose the fiber type for each span in the network.

Span Length—Type the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

EOL Ageing Factor—Type the number to use when factoring fiber aging. This factor is multiplied
by the SOL total span loss without connectors.

EOL Ageing loss [dB]—Type the EOL aging loss value. The EOL loss-per-span value is added at
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

N

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a
value in both fields.

Connector loss [dB]—Type the concentrated loss at the end of the span.
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e (D factor [ps/mn/km]—Type the fiber chromatic dispersion (CD) factor. The default value is
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm; L-band
is defined at 1590.4 nm.

e PMD factor [ps/sqrt(km)]—Type the polarization mode dispersion (PMD) factor. The default value
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you
change the fiber type. PMD is always entered in kilometers.

e Length Based Loss—If checked, the fiber loss is determined by Span Length * Loss Factor. If the
check box is not checked, you must enter the total loss of the span.

e If the check-box is not checked then the user needs to insert the total loss of the span

e Loss factor [dB/km]—Type the value of the SOL fiber loss per kilometer that is used to calculate
the loss of each span in the network. The fiber loss factor is always entered in dB/km.

e Tot SOL loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor
multiplied by the length. In the Length Based model, this value is calculated automatically.

Figure 2-18 Network Creation Wizard Span Parameters Page
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Step 14  Click Finish. Cisco MetroPlanner checks the validity of the fiber factor values. If the fiber factor values
are within the valid range (Table 2-5), Cisco MetroPlanner creates a visual representation of the
network. If the values are out of range, Cisco MetroPlanner issues a warning, asking you to confirm the
input values.
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Min. Min. Max. Max.
Error Warning |Default |Warning |Error

Fiber Type Parameter Value |Value Value Value Value Unit
ITU-T Loss factor 0 0.2 — 0.4 10 dB/km
G.652-SMF | cpromatic 0 16.2 16.7 17.1 30 ps/nm/km

dispersion factor

at 1545.3 nm

(C-band)

Chromatic 0 18.53 19.03 19.43 30 ps/nm/km

dispersion factor

at 1590.4 nm

(L-band)

PMD factor Ops/ (0.0 0.1 0.5 10 pafifirn)
ITU-T Loss factor 0.2 — 0.4 10 dB/km
G.655-E-LEAF | oo matic 3.4 3.80 42 10 ps/nm/km

dispersion factor

at 1545.3 nm

PMD factor 0 0.1 0.5 10 pafiflan)
ITU-T Loss factor 0.2 — 0.4 10 dB/km
G.655-True | Cpromatic 3.8 4.19 4.6 10 ps/nm/km
Wave dispersion factor

at 1545.3 nm

PMD factor 0 0.1 0.5 10 pafiflan)
ITU-T Loss factor 0.2 — 0.4 10 dB/km
G.652-DS Chromatic 2.43 2.83 3.23 30 ps/nm/km
(D.1sper510n dispersion factor
shifted) at 1590.4 nm

(L-band)

PMD factor 0 0 0.1 0.5 10 pafivlan)

2.3.1 Adding Sites

Use the following procedure to add new sites to an existing network. A site is a customer premise
location where any equipment can be co-located in a rack within a building. You can add new sites to a
network in the Design state only.

Note

Every new site added to a design is automatically configured as Multi-Shelf Integrated Switch with
Same Shelf protection. To change this, you can edit the site properties after adding it to the network
design. See the “2.6.3 Editing Site Parameters” section on page 2-67.
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Note

Step 1
Step 2

Step 3

Step 4

Cisco MetroPlanner supports up to 60 sites. The maximum number of locations where the optical service
channel (OSC) is terminated is 20. The maximum number of add/drop locations is 16.

Right-click the network folder in the Project Explorer and choose Expand from the shortcut menu.

Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard
appears. As an alternative, if sites already exist in the network design and you have the NtView <Name>
tab open, click the Create a new site icon in the toolbar. For more information about the

Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Choose the interface type:
e Line—Two pairs of fibers are terminated at the node.
e Terminal—A single pair of fibers is terminated at the node.

¢ Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An
MMU card (topology upgrade) must be installed.

e Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be
increased. An MMU card (topology upgrade) must be installed.

Click Finish.

2.3.2 Adding Fiber Spans

Note

Step 1
Step 2

Step 3

Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the
NetView Net# tab. Within a fiber duct, more than one fiber pair can exist. You can add new fibers to a
network in the Design state only.

The number of fiber spans that each site can support is defined in the site properties. See the
“2.3.1 Adding Sites” section on page 2-29 or the “2.6.3 Editing Site Parameters” section on page 2-67.

In the NtView <Name> tab, click the Create a new duct icon in the toolbar. For more information about
the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Click one of the sites that you want to connect with a fiber span. This site will be the source site for later
network analysis output.

Click the destination site. A fiber span appears between the two sites. This site will be the destination
site for later network analysis output.

For the first span, the source site is set as East and the destination site is set as West. Cisco MetroPlanner
automatically adjusts East and West for additional spans.

2.3.3 Creating a Point-to-Point Demand

Use the following procedure to add a point-to-point traffic demand:
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Step 1 In the NtView <Name> tab, click the Create a new P2P demand icon in the toolbar. For more information
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step2  Click the source site of the demand.

Step3  Click the destination site of the demand. The Point to Point Demand Creation Wizard appears
(Figure 2-19).

Figure 2-19 Point to Point Demand Creation Wizard
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Step4  In the General Parameters area, complete the following:
e Label—Type the name of the demand.
¢ Source—(Display only) Displays the source site name.
¢ Destination—(Display only) Displays the destination site name.

¢ Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.2.6 Service Support” section on page 1-4.

e Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

e Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Step 5 Click Next.
Step6  In the Platform Parameters area, complete the following:

¢ Protection—Choose the protection type from the drop-down list: Y-Cable Protected, Client 1+1,
Fiber Switched, or Unprotected. For more information on protection types, see the
“1.2.5 Protection Scheme Support” section on page 1-3.
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Step 7

Step 8

Step 9

Note

e Path—(Unprotected only) Choose the routing type from the drop-down list:

— Auto—Allows the highest degree of flexibility in routing the channels. Cisco MetroPlanner
routes the channels with the lowest possible cost given the other constraints.

— E—Routes all the channels from the east side of the source site.
— W-—Routes all the channels from the west side of the source site.

e Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will
be optically bypassed. A channel in optical bypass is dropped on one side of the node and added on
the other side of the same node to allow the future use of that node as an add/drop location.

Complete the following fields in the Interface Parameters area. The options available are based on the
service type selected in Step 4.

e Transponder—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

¢ Line Card—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

e Alien Card—Displays only if you created a third-party interface as described in the “2.2.5 Defining
Third-Party DWDM Interfaces” section on page 2-12. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

e Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination
from the Source and Destination drop-down lists. This option is available for transponder and
muxponder interfaces that have pluggable client interfaces, and depends on the selected service type and
card type.

Click Finish. The Edit Point to Point Demand dialog box appears listing the present and forecast
channels.

The demand appears in the NtView <Name> tab and in the Project Explorer tree in the Service
Demands > Point To Point folders. A demand is a solid line when selected and a dotted line when not
selected. The line has a number above it that indicates the number of channels that are present.
Figure 2-20 shows a selected point-to-point demand with five channels between Sites 1 and 2.

To make changes to the demand parameters, see the “2.6.6 Editing a Point-to-Point Demand” section
on page 2-73, or click Cancel to close the Edit Point to Point Demand dialog box.

Figure 2-20 Point-to-Point Demand Between Two Sites

151658

2.3.4 Creating a Protected Ring Demand

Use the following procedure to create a P-ring traffic demand.
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Step1  Create a ring network using either the procedures in the “2.3 Creating a Project” section on page 2-23
or by manually placing sites into a ring configuration.

Step2  In the Native Net# tab, click the Create a new P-Ring demand icon in the toolbar. The P-Ring Creation
Wizard appears (Figure 2-21). For more information about the Cisco MetroPlanner icons, see
Appendix A, “GUI Information and Shortcuts.”

Figure 2-21 P-Ring Creation Wizard
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Step3  In the General Parameters area, complete the following:
e Label—Enter the name of the demand.

e Service Type—Choose the service type from the drop-down list. For a list of services, see the
“1.2.6 Service Support” section on page 1-4.

e Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically
updates with the number entered in this field.

¢ Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two
channels in the future, enter 6.

Step4  Click Next.

Step5  In the Protection Sites area, press Ctrl and click the sites that you want to add to the P-ring. A P-ring
requires at least three sites. Click the right arrow button. To remove a site added to the list, click the site
and click the left arrow button.

Step6  In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the
right arrow button. To remove a site added to the list, click the site and click the left arrow button.

Step 7 Click Next.
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Step 8

Step 9

Step 10

Note

Complete the following interface parameters. The options available are based on the service type
selected in Step 3.

¢ Transponder—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

¢ Line Card—Click to expand, then check the card type check box to select the card at the end sites
of the service channels.

¢ Alien Card—Displays only if you created a third-party interface as described in the “2.2.5 Defining
Third-Party DWDM Interfaces” section on page 2-12. Click to expand, and then check the card type
check box to select the card at the end sites of the service channels.

e Pluggable Card—Click to expand, then check the card type check box to select the card at the end
sites of the service channels.

In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination
from the Source and Destination drop-down lists. This option is available for transponder and
muxponder interfaces that have pluggable client interfaces, and depends on the selected service type and
card type.

Click Finish. The Edit P-Ring Demand dialog box appears.

The demand appears in the NtView <Name> tab and in the Project Explorer tree in the Service
Demands > P-Rings folders. A demand is a solid line when selected and a dotted line when not selected.
The line has a number above it that indicates the number of channels present. Figure 2-22 shows a
selected one-channel P-ring between Sites 1, 2, 3, and 5 with an optical bypass of Site 4.

To make changes to the demand parameters, see the “2.6.7 Editing a P-Ring Demand” section on
page 2-74, or click Cancel to close the Edit P-Ring Demand dialog box.

Figure 2-22 P-Ring Demand
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2.3.5 Creating a ROADM Demand

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Step 9
Step 10

Step 11

Step 12

Step 13

Use the following procedure to create ROADM traffic groups and demands:

In the Project Explorer, right-click the Groups folder and choose Expand from the shortcut menu.

Right-click the ROADM folder and choose Create new ROADM group from the shortcut menu. The
ROADM Group Creation Wizard appears.

Type the ROADM traffic group name in the Group Name field.
Check the desired sites.
Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer.

Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut
menu. The Create ROADM Demand dialog box appears (Figure 2-23).

Figure 2-23 Create ROADM Demand Dialog Box
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Enter a name for the demand in the Demand Name field.

Select a traffic pattern type (Hub or Meshed) from the Traffic Type drop-down list. If you select Hub,
the First Site drop-down list becomes available. If you selected Meshed, proceed to Step 10.

For Hub traffic types, select the originating site from the First Site drop-down list.

Select a connectivity type from the Connectivity type drop-down list: Protected, Unprotected
Minimum Hop, Unprotected Optimum Path, or Unprotected Subnet. Refer to the “1.5.3 ROADM
Traffic Demands” section on page 1-10 for more information on the connectivity choices. If you chose
Unprotected Subnet, continue with the next step; otherwise proceed to Step 12.

If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed
from the drop-down lists.

In the Service Types list, check the boxes for one or more client service types for the ROADM demand.
The client interfaces that support each service type appear in the table to the right of the Service Types
list.

To further define the client interfaces, complete the following options for each client interface listed in
the table. Check boxes in gray are not available for selection.
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Step 14

e Yes/No—Check to select this card to implement the service type.

¢ Client Interface—(Display only) Displays the card type for the selected service type.

e Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

¢ 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

¢ Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.
¢ Supported Service—(Display only) Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default,
Cisco MetroPlanner checks the best client interface to support each service.

Click OK to create the demand.

2.3.6 Deleting a Network

To delete a network from a project, in the Network Mgmt Tree tab click the network and choose Delete
from the Tasks Pane. You cannot delete a network if it is the only network in a project.

2.3.7 Adding Notes to a Project

Step 1
Step 2
Step 3

Step 4

Step 5

Use the following procedure to add a note to any item in the Project Explorer. Each network has a Notes
folder in the Project Explorer. After you have created a note, it appears in the Notes folder for that
particular network.

Right-click the desired item in the Project Explorer and choose Edit Note from the shortcut menu.
In the Edit Note creation box, enter the desired text.

To close the Edit Note creation box and to save the note, click the X in the upper right corner of the
window.

To view notes, double-click the Notes folder. The Notes window appears. Table 2-6 lists the columns in
the Notes window.

Table 2-6 Notes Window

Column Description

Header Displays the note text. To view the entire note, click the plus (+) sign next to the header
to expand the text.

Action Click Go to open the item in the Project Explorer where the note was created.

Source Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2. W.

To close the Notes window, click the X in the upper right corner of the window.
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2.3.8 Deleting Notes

Step 1
Step 2

Step 3

Use the following procedure to delete a note from any item in the Project Explorer:

Double-click the Notes folder.

In the Notes window, click Go in the Action column for the note that you want to delete. The item is
highlighted in the Project Explorer.

Right-click the item in the Project Explorer and choose Delete Note from the shortcut menu.

2.4 Analyzing the Network

Step 1
Step 2

Step 3

Step 4

Note

After you have created the desired sites, fiber spans, and service demands, you must analyze the network
to determine network performance. The network must be in the Design, Install, or Upgrade state before
you can analyze it. Cisco MetroPlanner automatically optimizes the design and summarizes the optical
transmission performance. If there are problems with the design, Cisco MetroPlanner lists the problems
and descriptions in the Analyzer Messages pane.

Use the following procedure to analyze the network:

Click the Networks Mgmt Tree tab, and click the network that you want to analyze.

Click the Analyze Network icon in the toolbar. For more information about the Cisco MetroPlanner
icons, see Appendix A, “GUI Information and Shortcuts.” As an alternative, click Analyze in the Tasks
Pane.

The MetroPlanner analyzer status window appears to indicate the progress. The Cisco MetroPlanner
analysis status bar indicates when the network analysis is complete.

If any problems occur during the analysis, click the Analyzer tab to view the results on the Analyzer
Messages pane. The Summary report appears. See the “2.5.1 Viewing the Summary Report” section on
page 2-38 for more information. Warning and error messages help you identify problems with your
current design. For a list of all system messages, see Appendix C, “System Messages.”

If necessary, resolve the problems listed in the Summary report. After you resolve the problems in the
network, you can analyze the network again.

You can return a Design-Analyzed network to the design state to make further changes by clicking the
network icon in the Networks Mgmt Tree and clicking Design in the Tasks Pane.

2.5 Viewing Network Reports

Cisco MetroPlanner provides the reports listed in Table 2-7. Report availability depends on whether a
network has been analyzed or whether it is in the Install or Upgrade state. Reports are also available by
site. See Table 2-7 for report availability details.
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Note

Although the following procedures use the Tasks Pane to access reports, you can also access reports by
clicking the desired report in the Project Explorer tree Reports folder.

Table 2-7 Report Availability

Report Network Availability Site Availability
NE Update Analyzed —

Installation Parameters Analyzed Analyzed
Traffic Matrix Analyzed Analyzed

Layout Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed
Link Availability Analyzed Analyzed

Internal Connections Analyzed —

Optical Results Analyzed Analyzed

Wavelength Routing Analyzed —

Summary Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Bill of Material

Install, Upgrade, and Analyzed

Install, Upgrade, and Analyzed

For more information on the Bill of Materials report, see the “2.8 Generating a BoM” section on
page 2-89. In addition, you can compare the following reports using the Reports Diff tool: Bill of
Material, Internal Connections, and Installation Parameters.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “2.1.1 Opening a Project” section on page 2-3 and the “2.1.2 Loading and Unloading Networks”

section on page 2-3.

2.5.1 Viewing the Summary Report

Step 1

Step 2

The Summary report summarizes design information, optical results, design cost, and analyzer
messages. You can view it before or after you analyze a network. It automatically appears when you
analyze a network. Use the following procedure to view the report at another time:

Complete one of the following:

e To view the Summary report for a network, click the Networks Mgmt Tree tab and click the

network.

e To view the Summary report for a site, click the NtView <Name> tab and click the site.

In the Tasks Pane, click Summary. The Summary tab appears (Figure 2-24).
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Figure 2-24 Summary Tab
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Table 2-8 lists the categories in the Summary tab and their descriptions.

Table 2-8 Summary Tab Categories

Category Description

Design info Displays the following information:
e Version—Displays the Cisco MetroPlanner software release version.

e (Customer name—Displays the name of the customer requiring this network
design.

¢ Created By—Displays the user login name.

e Release—Displays the Cisco MetroPlanner software release number.

Optical results  |Indicates how many demands are included in the network, and identifies the number
and severity of alarms for each demand.
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Table 2-8 Summary Tab Categories (continued)

Category Description

Design cost info |Displays the following information:
¢ Price list—Displays the price list used.
e Currency—Displays the currency selected for the price list.

¢ BoM total discounted—Displays the total price of the products (excluding spare
parts) in the network with the discount applied.

e Spare total discounted—Displays the total price of the spare parts in the
network with the discount applied

e BoM + Spare total discounted—Displays the total price of the products
(including spare parts) in the network with the discount applied.

Messages Displays any analyzer messages that occurred as a result of network analysis.
Warning and error messages will help you identify problems with your current
design. For a list of all system messages, see Appendix C, “System Messages.”

2.5.2 Saving the NE Update File

Step 1
Step 2
Step 3

Step 4

After Cisco MetroPlanner completes network analysis, you can create a configuration file. If the system
release is 7.0, a single XML file is created including all of the parameters for all the sites in the network;
if the system release is 4.7 or 5.0, a single TXT file is created for each site in the network. This file can
be directly imported to a site using the NE Update feature in CTC. CTC uses this file to preprovision a
node.

Each file is named with the site name string by default. The list of reported installation parameters
depend on the system release selected for the designed network. You generally save this file after you
analyze an Install network.

Use the following procedure to save the NE Update file:

Click the Networks Mgmt Tree tab, and click the analyzed network.
In the Tasks Pane, click NE Update. The Network Element Update File dialog box appears.

Check the Include wavelength parameters check box to include trunk wavelength preprovisioning in
the NE Update XML file. Do not check this box if the network on which you import the NE Update file
is using system release 7.0.0. If this option is checked, trunk wavelength is preprovisioned in CTC for
all the TXP and MXP units required to support present traffic demands.

~

Note During project creation, selecting MSTP- Release 7.0 allows you to create projects for system
releases 7.0.0 and 7.0.x. However, when importing the NE Update file on a node using system
release 7.0.0, the node cannot read the NE Update XML file if Include wavelength parameters
is checked.

To save the file in a different directory than the Destination Folder, click Change and navigate to the
desired directory. Click Save.
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Step5  Click Finish.

Step6  Click Cancel to close the window without saving a configuration setup file.

2.5.3 Viewing the Installation Parameters

The Installation Parameters reports shows the values to be set (provisioned) at installation time on each
site in the network. These parameters are exported when you save the NE Update file and are used to
automatically provision a node using CTC.

Use the following procedure to view the installation parameters after a network has been analyzed:

Step 1 Complete one of the following:

e To view the Installation Parameters report for a network, click the Networks Mgmt Tree tab and
click the network.

e To view the Installation Parameters report for a site, click the NtView <Name> tab and click the
site.

Step2  Inthe Tasks Pane, click Installation Parameters. The Installation Parameters tab appears (Figure 2-25).
The ANS view subtab appears by default. This tab displays the Automatic Node Setup information.

Figure 2-25 ANS View Subtab in the Installation Parameters Tab
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Table 2-9 describes the columns on the ANS view tab of the Installation Parameters report.

Table 2-9 Installation Parameters Report ANS View Tab Columns

Category Description

Name Displays the name of the site.

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord
originates.
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Step 3

Step 4

Step 5

Table 2-9 Installation Parameters Report ANS View Tab Columns (continued)

Category Description

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.

Measurement Displays the measurement unit for the related installation parameter value, such as
Unit dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC

interface.

Click the ANP view tab to view the Automatic Node Provisioning information. Table 2-10 describes the
columns on the ANP view tab of the Installation Parameters report.

Table 2-10 Installation Parameters Report ANP View Tab

Category Description
Name Displays the name of the site.
Shelf ID Displays the shelf identifier.

Rack number

Displays the rack number.

Rack position

Identifies the rack position in the shelf.

Slot position

Identifies the slot position in the shelf for the card.

Equipment type

Displays the card type.

Click the PP view tab to view the Provisioning Parameters information. Table 2-11 describes the
columns on the PP view tab of the Installation Parameters report.

Table 2-11 Installation Parameters Report PP View Tab

Category Description
Name Displays the name of the site.
Shelf ID Displays the shelf identifier.

Slot position

Displays the slot number for the card with the PPM.

Port position

Displays the port number.

Ppm position

Displays the PPM location on the card.

Pp name

Displays the name of the PPM.

value

Displays the installation parameter value.

To close the Installation Parameters report, click the X on the top right of the Installation Parameters tab.
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2.5.4 Viewing Internal Connections

Step 1
Step 2

Viewing Network Reports

Use the following procedure to view the network internal connections after a network has been analyzed.

You can also use this procedure to view the patchcord connections between transponders and the
Y-Cable Protection modules. The Y-Cable Protection position is defined using the rack and shelf

number. The slots are numbered from left to right on each of the four modules that can be placed in a

shelf.

Click the Networks Mgmt Tree tab, and click the analyzed network.

In the Tasks Pane, click Internal Connections. The Internal Connections tab appears (Figure 2-26).

Figure 2-26 Internal Connections Tab
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Table 2-12 lists the columns in the Internal Connections tab and their descriptions. Click a columns to
sort the table information by that column.

¢ Click the Patchcord installation view subtab to view all the patchcord connections that the installer
has to mechanically cable within the site between the different ports of the cards.
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Step 3

Step 4

e Click the SW Provisioning view subtab to view the patchcord representation on the local Cisco
Transport Controller (CTC) interface. This subtab contains all the connections to be manually set or
removed with respect to the default connections that are automatically generated by the software
running on the node.

Table 2-12 Internal Connections Tab Columns

Column Name

Description

Name Displays the name of the site. On the SW provisioning view subtab, this column
indicates whether the connection should be manually set using the CTC interface or
removed.

Position-1 Displays the rack, shelf, and slot position of the card from which the patchcord
originates.

Unit-1 Displays the name of the card.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord
terminates.

Port ID-1 (SW provisioning view subtab only) Displays the port ID.

Port label-1

Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this
connection. It also reports when an internal attenuator must be placed between the
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position-2 Displays the rack, shelf, and slot position of the card where the patchcord
terminates.

Unit-2 Displays the name of the card.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord
terminates.

Port ID-2 (SW provisioning view subtab only) Displays the port ID.

Port Label-2

Displays the name of the port.

P/F

Displays whether the connection relates to a present or forecast circuit.

To export the information to an external file, click Export. In the Internal connections export dialog box,
type the name of the file and navigate to the desired folder. Click Save.

To close he Internal Connections tab, click the X in the upper right corner of the tab.

2.5.5 Viewing the Traffic Matrix Report

The Traffic Matrix report displays the point-to-point, P-ring, and ROADM channel data. Use the
following procedure to view the traffic matrix report:

Step 1

Complete one of the following:

e To view the Traffic Matrix report for a network, click the Networks Mgmt Tree tab and click the

network.

e To view the Traffic Matrix report for a site, click the NtView <Name> tab and click the site.
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In the Tasks Pane under Reports, click Traffic Matrix. The Traffic Matrix tab appears. A default query
opens.

Figure 2-27 Traffic Matrix Tab
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Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in
the columns. The Traffic Matrix report displays separate rows for the TX and RX direction of the optical
channels.

~

Note  To add a column to the report, right-click a column and choose the column name from the
shortcut menu. The column names with checks in the shortcut menu appear on the report. To
remove a column, right-click and choose the column (checked) from the shortcut menu.

Table 2-13 Traffic Matrix Tab Columns

Column Label Description

Service Demand Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the

plus (+) sign by a demand type to expand and show the optical channels.

Service Circuit
OCH CC Source
OCH CC Source

Displays the optical channel label; for example, Sitel-Site2.

Displays the site name for the optical channel source.

Displays the rack, shelf, and slot identifiers for the source of the optical channel.

Position The format of the field is Rack.Shelf.Slot.

OCH CC Source Displays the unit name for the optical channel source.

Unit

OCH CC Source Displays the port for the source of the optical channel; for example, Client RX.
Port

OCH CC Dst Displays the site name for the optical channel destination.
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Step 3

Table 2-13 Traffic Matrix Tab Columns (continued)

Column Label Description
OCH CC Dst Displays the rack, shelf, and slot identifiers for the destination of the optical
Position channel. The format of the field is Rack.Shelf.Slot.

OCH CC Dst Unit

Displays the product ID for the optical channel destination.

OCH CC Dst Port

Displays the port for the destination of the optical channel; for example, Client
TX.

A/D Source Displays the site name for the add/drop channel source.
A/D Source Displays the rack, shelf, and slot identifiers for the source of the add/drop
Position channel. The format of the field is Rack.Shelf.Slot.

A/D Source Unit

Displays the unit name for the add/drop channel source.

A/D Source Port

Displays the port for the source of the add/drop channel; for example, Client RX.

A/D Dst

Displays the site name for the add/drop channel destination.

A/D Dst Position

Displays the rack, shelf, and slot identifiers for the destination of the add/drop
channel. The format of the field is Rack.Shelf.Slot.

A/DDst Unit

Displays the product ID for the add/drop channel destination.

A/D Dst Port

Displays the port for the destination of the add/drop channel; for example, Client
TX.

Cl. Serv. Type

Displays the client service type of the demand; for example, OC-48.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.
Wavelength Displays the wavelength of the optical channel.
Opt Bypass Identifies where the optical channel is dropped and reinserted when it is not

terminated on a TXP or MXP card (optical bypass). If “none” appears in the Op
Bypass column, no optical bypass is defined for the optical channel.

DWDM Interface
Type

Identifies the DWDM interface type that is used for the optical channel:

e Transponder indicates that an MSTP transponder, an MSTP muxponder, or a
DWDM pluggable port module is used for the optical channel.

e Line Card indicates that an ITU line card is used for the optical channel.

DWDM Card Type

Identifies the type of transponder or line card used for the optical channel.

To create a new query, click New Query to open the Query Dialog (Figure 2-28). The Query Dialog
allows you to filter the optical results using a variety of parameters and templates.
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Figure 2-28 Query Dialog
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Step4  To perform a query using individual parameters, select the desired parameters from the drop-down lists
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of
the screen. Table 2-14 describes the fields in the Query Dialog.

Table 2-14 Query Dialog Fields

Column Label Description

Group Allows you to filter the report to include only the data in the selected group. You
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand.
The demand field is available only when you select a specific traffic group.

DWDM Card Type |Allows you to filter the report to include only the data in the selected DWDM
card type.

Source Allows you to filter the report to include only the results of incoming/outgoing
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green,
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the
Optical Results Table.
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Step5  Choose one of the following, as needed:

¢ Click Run Query. The window closes, and the query results appear in the Traffic Matrix tab
(Figure 2-27). The parameters of the query appear in the horizontal area just below the button bar.

¢ Click Reset Query to clear your selections in the Query Dialog.
¢ Click Close to close the window without running a query.

Step6  To close the Traffic Matrix report, click the X in the upper right corner of the tab.

2.5.6 Displaying the Layout

Use the following procedure to view a graphical representation of each site in an analyzed network:

Step 1 Click the NtView <Name> tab and click the desired site.

Step2  In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-29). To change sites, choose the
desired site from the drop-down list.
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Figure 2-29 Layout Report (Rack View)
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Step3  From the Site drop-down list, choose the site in the network to display in the layout report.

Step4  In the tree view on the left of the tab, right-click a rack and choose Expand to view a list of all shelves
and cards in the rack.

Step5  Click the desired rack or shelf to view it in the layout graphic. Figure 2-30 displays the shelf view.
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Figure 2-30 Layout Report (Shelf View)
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Step6  To view details about a card, double-click the card. The Details dialog box opens with client information:
e Label—Displays the name of the card.
e Product ID—Displays the product ID of the card.
e Service Category—Future use.
e Description—Provides a brief description of the card functionality.
e Price—Lists the price for the card based on the price list selected during project creation.
e ITU Channel—Identifies the ITU channel wavelength for the card.

For transponder and muxponder cards, click the Modules subtab in the Details dialog box to view which
pluggable port modules are to be used for each TXP/MXP unit:

e P/F—P refers to pluggable port modules that support the present client demand, while F refers to
pluggable port modules that support the future client demand.

e Module PID—Displays the pluggable port module product ID.

e Ch#—Displays the number of the port on the unit and identifies where the pluggable port module is
to be installed.

Click Close to close the Details dialog box.
Step7  To filter the layout display, choose one of the following from the drop-down list:

e Any—Displays all cards for both the present and forecast traffic demand.
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e Present—Displays cards for only the present traffic demand.
¢ Locked & Unlocked—Highlights the locked and unlocked cards in the layout.
e Alarmed—Highlights the alarmed cards in the layout.

After network analysis, all items are in locked mode. To unlock cards so that Cisco MetroPlanner can
rearrange the layout to optimize slot usage during network analysis, right-click locked card in the rack
tree and choose Unlock.

~

Note

You can unlock only on Upgrade networks in the Design state.

To export the graphical representation of the layout in JPEG format, click Export. In the Layout export
dialog box, type the name of the file and navigate to the desired folder. Click Save.

To zoom the layout graphic in or out, click the Zoom In and Zoom Out icons. For more information about
the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

To close the Layout report, click the X in the upper right corner of the tab.

2.5.7 Viewing Power Consumption from the Layout Report

Step 1
Step 2

Step 3

Use the following procedure to view the power consumption for each unit of equipment in a site. Power
consumption is available in report form from the Layout report.

Click the NtView <Name> tab and click the desired site.

In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-29 on page 2-49). To change sites,
choose the desired site from the drop-down list.

Click the View layout as table icon in the report tool bar. The Layout Table report appears (Figure 2-31).

Figure 2-31 Power Consumption
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Table 2-15 describes the information in the columns.

Table 2-15 Layout Table (Power Consumption) Columns

Column Label Description

Name Lists the equipment at the site.

Position Identifies the rack, shelf, or slot location for applicable units of equipment.
Description Describes each equipment type.

Max Power Displays the maximum power consumption for each unit of equipment.

Consumption (W) Note  For transponder/muxponder cards with pluggable port modules, the

maximum power consumption shown is for the board fully equipped with
the maximum number of pluggable port modules.

Average Power Displays the average power consumption for applicable units of equipment.

Consumption (W) Note  For transponder/muxponder cards with pluggable port modules, the

average power consumption shown is for the board fully equipped with
the maximum number of pluggable port modules.

Step4  To export power consumption data, click Export. The Layout table export dialog box appears. Type the
name of the file and navigate to the desired folder. Click Save.

Step5  Click Close to close the Layout Table report.

2.5.8 Viewing the Link Availability Report

Cisco MetroPlanner determines link availability based on unit failure rate and time to repair. Use the
following procedure to view the Link Availability report:

Step1  Complete one of the following:

e To view the Link Availability report for a network, click the Networks Mgmt Tree tab and click
the network.

e To view the Link Availability report for a site, click the NtView <Name> tab and click the site.

Step2  In the Tasks Pane, click Link Availability. The Link Availability tab appears (Figure 2-32).
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Figure 2-32 Link Availability Report
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Each row in the tab shows the performance of one optical path. Table 2-16 describes the information in
the columns.

Table 2-16 Link Availability Tab Columns

Column Label Description

Group Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the

plus (+) sign by a demand type to expand and show the optical channels.

Serv. Circuit Displays the optical channel label; for example, Sitel-Site2.

P/F Identifies whether the channel is present and forecast (P/F) or forecast (F).
DWDM Card Type |Identifies the type of transponder or line card used for the optical channel.
Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Cl. Serv. Type

Displays the client service type of the demand; for example, OC-48.

Source Displays the site name for the optical channel source.
Destination Displays the site name for the optical channel destination.
Link Availability Displays the link availability percentage. Link availability is calculated based on

(% Complete)

the failure rate and time to repair.

Click New Query to open the Query Dialog (Figure 2-28 on page 2-47). The Query Dialog allows you
to filter the link availability using a variety of parameters.

To perform a query using individual parameters, select the desired parameters from the drop-down lists
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of
the screen. Table 2-17 describes the fields in the Query Dialog.

Table 2-17 Query Dialog Fields

Column Label

Description

Group Allows you to filter the report to include only the data in the selected group. You
can also view groups in the Project Explorer view under the network folder.
Demand Allows you to filter the report to include only the data in the selected demand.

The demand field is available only when you select a specific traffic group.
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Table 2-17 Query Dialog Fields (continued)

Column Label Description

DWDM Card Type |Allows you to filter the report to include only the data in the selected DWDM
card type.

Source Allows you to filter the report to include only the results of incoming/outgoing
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified
wavelength.

P/F Allows you to filter the report to include only present services, only forecast

services, or both.

Step5  Choose one of the following, as needed:

¢ Click Run Query. The window closes, and the query results appear in the Link Availability tab. The
parameters of the query appear in the horizontal area just below the button bar.

¢ Click Reset Query to clear your selections in the Query Dialog.
¢ Click Close to close the window without running a query.

Step6  To close the Link Availability report, click the X in the upper right corner of the tab.

2.5.9 Viewing Optical Results

Use the following procedure to view the optical results of the network that you created and analyzed:

Step 1 Complete one of the following:

e To view the Optical Results report for a network, click the Networks Mgmt Tree tab and click the
network.

e To view the Optical Results report for a site, click the NtView <Name> tab and click the site.

Step2  In the Tasks Pane, click Optical Results. The Optical Results tab appears (Figure 2-33).
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Figure 2-33 Optical Results Tab
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Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in

the columns.

Table 2-18 Optical Results Tab Columns

Column Label

Description

Name

Displays the identification number automatically given to each path in the order
that the channels were entered into the design.

Group

Identifies the demand group for the optical channel.

Protect

Displays the protection type of the channel. For a protected channel, both paths
are shown. The path leaving the east side of the source is shown first.

SOL

Displays the results summary of the analysis run with Start of Life fiber loss
values. The indicator shows the optical performance for the each direction of the
bidirectional Optical Channel Trail (OCH Trail). Green indicates success, yellow
indicates success with a marginal failure risk (between 0 and 16 percent), orange
indicates that the channel has a higher risk of failure (between 16 and 50
percent), and red indicates failure.

EOL

Displays the results summary of the analysis run with End of Life fiber loss
values. The indicator shows the optical performance for the each direction of the
bidirectional Optical Channel Trail (OCH Trail). The indicator shows the optical
performance for the path at the end of the fiber’s life. Green indicates success,
yellow indicates success with a marginal failure risk (between 0 and 16 percent),
orange indicates that the channel has a higher risk of failure (between 16 and 50
percent), and red indicates failure.
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Table 2-18 Optical Results Tab Columns (continued)

Column Label

Description

SE

Indicates a system-related error exists that may impact the analysis of the design.

If the indicator is red, review the messages reported at the end of the analysis or
determine which units or sites are having a problem.

Chr. Disp. [ps/nm]

Displays the value of the chromatic dispersion check. Green indicates that the
dispersion check passed. Red indicates that the dispersion check failed.

Penalty Displays the value and status of the penalties caused by the different filter types
(OADM, ROADM, and arrayed wavelength grating [AWG]). Green indicates
that the penalty check passed. Red indicates that the penalty check failed.

Wavelength Displays the assigned wavelength of the optical path.

P/F Displays the present/forecast services indication.

Source Displays the name of the source site and side; for example, Site 1-E.

Destination Displays the name of the destination site and side; for example, Site 1-E.

Span (km) Displays the total span length (source -> destination) for this path in kilometers.

Tx Type Displays the type of DWDM unit or pluggable port module used for the specific
OCH Trail.

BER target Displays the bit error rate (BER) target for this channel based on the capability

of the channel’s optical interface. It is 1.0E-15 for the interfaces using forward
error correction (FEC) and 1.0E-12 for interfaces without FEC.

SOL OSNR (dB)

Displays the start of life average optical signal-to-noise ratio (OSNR) value at the
receiver. OSNR refers to the selected resolution bandwidth (RBW) bandwidth.

EOL OSNR (dB)

Displays the end of life average OSNR value at the receiver. OSNR refers to the
selected RBW bandwidth.

SOL OSNR Margin
(dB)

Displays the SOL OSNR margin calculation, which is the difference between the
OSNR value at a certain power of the working point of the receiver client and the
working area boundary.

EOL OSNR Margin
(dB)

Displays the EOL OSNR margin calculation, which is the difference between the
OSNR value at a certain power of the working point of the receiver client and the
working area boundary.

SOL RX (dBm)

Displays the SOL received average power at the destination site in dBm.

EOL RX (dBm)

Displays the EOL received average power at the destination site in dBm.

SOL Power margin
(dB)

Displays the SOL power budget margin at the receiver in decibels. It is defined
as the offset between the receiver working point and the BER curve with margin.
A positive value indicates no power problems.

EOL Power margin
(dB)

Displays the EOL power budget margin at the receiver in decibels. It is defined
as the offset between the receiver working point and the BER curve with margin.
A positive value indicates no power problems.

SOL Overload (dB)

Displays the SOL overload margin at the receiver in decibels. A positive value
indicates no overload problems.

EOL Overload (dB) |Displays the EOL overload margin at the receiver in decibels. A positive value
indicates no overload problems.
RX atten Displays the attenuation at the input of the receiver.
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Table 2-18 Optical Results Tab Columns (continued)

Column Label Description

PMD (ps) Displays the calculated total PMD for each circuit. This total includes all the
PMD components for the OCH Trail, including fiber and DWDM units on the
path. If the overall PMD for the link overcomes the maximum allowed, the PMD
value is colored red. The maximum allowed value depends on the client
interface. For these special cases, the network must be manually resolved by
contacting a Cisco optical sales engineer.

Latency Displays the latency time for the current circuit. This value includes all the
latency components for the OCH Trail, including fiber and DWDM units on the
path.

Step3  Click New Query to open the Query Dialog (Figure 2-28 on page 2-47). The Query Dialog allows you
to filter the optical results using a variety of parameters.

Step4  To perform a query using individual parameters, select the desired parameters from the drop-down lists
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of
the screen. Table 2-19 describes the fields in the Query Dialog.

Table 2-19 Query Dialog Fields

Column Label Description

Group Allows you to filter the report to include only the data in the selected group. You

can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand.

The demand field is available only when you select a specific traffic group.

DWDM Card Type |Allows you to filter the report to include only the data in the selected DWDM

card type.

Source Allows you to filter the report to include only the results of incoming/outgoing

services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing

services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified

wavelength.

Alarm Allows you to filter the report to include only services flagged with a green,

yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast

services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the

Optical Results Table.

Step5  Choose one of the following, as needed:

¢ Click Run Query. The window closes, and the query results appear in the Optical Results tab. The

parameters of the query appear in the horizontal area just below the button bar.

¢ Click Reset Query to clear your selections in the Query Dialog.

¢ Click Close to close the window without running a query.

Cisco MetroPlanner DWDM Operations Guide, R7.0.1
[ December 2010 .m



Chapter2  Designing Networks with Cisco MetroPlanner |

M Viewing Network Reports

Step6  To close the Optical Results report, click the X in the upper right corner of the tab.

2.5.10 Viewing Wavelength Routing

Use the following procedure to view the wavelength routing map for an analyzed network:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step2  In the Tasks Pane, click Wavelength Routing. The Wavelength Routing tab appears (Figure 2-34). Each
wavelength supported by the platform is represented by a row.

~

Note ROADM (Any-to-Any) demands are not shown in this report.

Figure 2-34 Wavelength Routing Tab
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Step3  Choose one of the following from the drop-down list: Any (to view both forecast and present routing),
Present (to view only the present routing), or Forecast (to view only the forecast routing). When you
select Any, Forecast demands are shown with a grey background.
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Table 2-20 describes the information in the columns.

Table 2-20 Wavelength Routing Tab Columns

Column Label Description
wl Lists the wavelengths supported by the platform.
Site # Represents a site in the network. The colors in the Site columns indicate for each

side of the site the SOL/EOL channel status. Green indicates success, yellow
indicates success with a marginal failure risk (between 0 and 16 percent), orange
indicates that the channel has a higher risk of failure (between 16 and 50
percent), and red indicates failure.

Duct # Represents a duct in the network.
w Represents the west side of a site.
E Represents the east side of a site.
Couple Represents a pair of fibers at a site.

Note  Tool tips are available on this report. Move the cursor over a Site column for circuit information,
card name, and product ID. Move the cursor over a Duct/Couple column for loss, length, and
fiber type.

To export the graphical representation of the layout in JPEG format, click Export. In the Wavelength
Routing export dialog box, type the name of the file and navigate to the desired folder. Click Save.

To close the Wavelength Routing report, click the X in the upper right corner of the window.

2.5.11 Viewing Report Differences

You can compare the BoM, Internal Connections, and Installation Parameters reports for two networks.
This is useful to see the differences between a baseline network and an Install or Upgrade network.

e The BoM Diff report lists the units that were added and/or removed from the BoM.

e The Internal Connection Diff report lists changed connections. If at least one of the two end points
of an internal connection is different, Cisco MetroPlanner reports that the internal connection has
changed. The report shows all internal connections that were present in the baseline network but are
not present in the final network, and all internal connections not present in the baseline network but
present in the final network.

¢ The Installation Parameters Diff report lists changed parameters between the baseline network and
the final network.

Use the following procedure to compare networks:

Step 1 Click the Reports Diff icon. For more information about Cisco MetroPlanner icons, see Appendix A,
“GUI Information and Shortcuts.” The Reports Diff dialog box appears. Figure 2-35 shows the Reports
Diff dialog box as it appears when at least two analyzed networks exist in a project.
Cisco MetroPlanner DWDM Operations Guide, R7.0.1
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Figure 2-35 Reports Diff Dialog Box

Reports Diff x|
~Compare networks
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{;& Installation Parameters
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Step2  In the Compare networks area, choose the baseline network from the drop-down list on the left. Choose
the network to compare from the drop-down list on the right.

151723

Step3  Click the report you would like to view. If you chose one non-analyzed network, you can view only the
Bill of Material differences report.

¢ Bill of Material—(Figure 2-36 on page 2-61) For a description of the columns, see Table 2-21 on
page 2-61.

¢ Installation Parameters—(Figure 2-37 on page 2-62) For a description of the columns, see
Table 2-22 on page 2-63.

¢ Internal Connections—(Figure 2-38 on page 2-64) For a description of the columns, see Table 2-23
on page 2-65.

Step4  Click Ok.
Figure 2-36 shows the BoM Diff report.
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Figure 2-36 BOM Diff Report
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The upper section of the BoM Diff Report tab displays the following information for each network:

¢ BoM total discounted—Displays the price for the overall network (without spare parts) for each item

in the BoM. If Use global discount is checked, the total includes the discount from the Global
discount percentage field.

e Spare total discounted—Displays the price for all of the recommended spare parts in all of the

maintenance centers for the overall network. It is the sum of each spare item using the discounted

price. The total appears after you check the Spare Part Report check box.

e BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total

discounted price.

e Price List—Displays the name of the price list database selected for the project.

e Currency—Displays the value of the currency used for each of the price values as specified within

the selected price list database.

Table 2-21 describes the information in the BoM Diff report columns. Click a column to sort the table

information by that column.

Table 2-21 BoM Diff Report Columns

Column Label Description
Name Displays the name of the site and equipment.
(Diff Summary) Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two
networks.

# (crossed-out equal sign)—Indicates that the item is present on
both networks, but the number per network is different.

second network.

the first network.

1—Indicates that this item is present in the first network but not in the

2—Indicates that this item is present in the second network but not in
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Table 2-21 BoM Diff Report Columns

Column Label Description

PID Displays the ID string of the product. To view a PID, click on the
plus (+) sign by the equipment name to expand it.

Quantity Displays the number of specific products in the BoM. If the networks
have a different quantity, Cisco MetroPlanner displays both numbers
in red in the following format: first network Quantity/second network
Quantity.

Unit Price Displays the price for each unit. To view a unit price, click on the
plus (+) sign by the equipment name to expand it.

Total Price Displays the total price of the products before applying the discount.
If the networks have a different quantity, Cisco MetroPlanner displays
both numbers in red in the following format: first network Total
Pricelsecond network Total Price.

Discounted Total Price Displays the total price of the products after applying the discount. If
the networks have a different quantity, Cisco MetroPlanner displays
both numbers in red in the following format: first network Discounted
Total Pricel/second network Discounted Total Price.

Figure 2-37 shows the Installation Parameters Diff report.

Figure 2-37 Installation Parameters Diff Report
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Table 2-22 describes the columns on Installation Parameters Diff report. Click a column to sort the table
information by that column.

Differences between networks appear in red and in the following format: baseline network valuelfinal
network value.
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Table 2-22 Installation Parameters Diff Report Columns

Category Description

Name Displays the name of the site.

(Diff Summary) |Indicates a difference exists between the two network BoMs:
= (equal sign)—Indicates that no difference exists between the two networks.

# (crossed-out equal sign)—Indicates that the item is present on both networks,

but the number per network is different.
1—Indicates that this item is present in the first network but not in the second
network.
2—Indicates that this item is present in the second network but not in the first
network.

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.

Measurement Displays the measurement unit for the related installation parameter value, such as

Unit dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC

interface.

Figure 2-26 shows the Internal Connections Diff report.
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Figure 2-38 Internal Connections Diff Report
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Table 2-23 lists the columns in the Internal Connections Diff report and their descriptions. Click a
column to sort the table information by that column.

Differences between networks appear in red and in the following format: baseline network value/final
network value.
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Table 2-23 Internal Connections Tab Columns

Column Name

Description

Name

Displays the name of the site. On the SW provisioning view subtab, this column
indicates whether the connection should be manually set using the CTC interface or
removed.

(Diff Summary)

Indicates a difference exists between the two network BoMs:
= (equal sign)—Indicates that no difference exists between the two networks.

# (crossed-out equal sign)—Indicates that the item is present on both networks,
but the number per network is different.

1—Indicates that this item is present in the first network but not in the second
network.

2—Indicates that this item is present in the second network but not in the first
network.

Position

Displays the rack, shelf, and slot position of the card from which the patchcord
originates.

Unit

Displays the name of the card.

Port label

Displays the name of the port.

Attenuator

When indicated, this is the product ID of the bulk attenuator to be equipped on this
connection. It also reports when an internal attenuator must be placed between the
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position

Displays the rack, shelf, and slot position of the card where the patchcord
terminates.

Unit

Displays the name of the card.

Port Label

Displays the name of the port.

P/F

Displays whether the connection relates to a present (P/F) or forecast (F) circuit.

a Project

Cisco MetroPlanner allows you to edit the a project either before or after network analysis. Error
messages that occur during network analysis often cannot be resolved until you edit one or more network

components.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “2.1.1 Opening a Project” section on page 2-3 and the “2.1.2 Loading and Unloading Networks”
section on page 2-3.

[ December 2010

Cisco MetroPlanner DWDM Operations Guide, R7.0.1 g



Chapter2  Designing Networks with Cisco MetroPlanner |

W Editing a Project

2.6.1 Editing Project Parameters

Use the following procedure to edit project parameters:

Step 1 Click Project in the Project Explorer.

Step2 In the Properties pane, complete the following as needed:

Customer—Type the name of the customer (128 character maximum) requiring this network design.
Created by—Type the user name (128 character maximum).

Units—Displays the span measurement unit: Km (kilometers) or Miles.

Price List—Choose the price database from the drop-down list.

Layout—Displays ANSI (the North American standard) or ETSI (the international standard) to
indicate the platform type. ANSI networks will not allow you to define SDH (ETSI) service
demands. ETSI networks will not allow you to define SONET (ANSI) service demands.

2.6.2 Editing Network Parameters

Use the following procedure to edit network parameters:

Step 1 Click a network in the Project Explorer or Networks Mgmt Tree.

Step2 In the Properties pane, complete the following as needed:

Name—Type the network name (128 character maximum).

Position—Type the object location in pixels.

Created by—Type the user name (128 character maximum).

Status—Displays the state of the network (Design, Design-Analyzed, Install, etc.).

Use MSM Bundles—Check to use the Multishelf Management Integrated Kit bundle when
generating the BoM instead of the single items.

Use Spare Parts—Check to determine the spare parts required by the network. If the network is in
the Upgrade state, the parts required to support the implemented services and the newly added
present services are included. To generate a spare parts report, you must associate the sites in a
network with a maintenance center before network analysis.

Use Global Discount—Check to use the global discount for the entire network. The global discount
is applied to all components in the BoM.

Global Discount—Enter a new global discount in the form of a percentage.

Service Level—Choose the service level (contract) identifier from the drop-down list.

Service Length—Choose the maintenance service level length (in years) from the drop-down list.
Include SW Licenses—Check to include software licenses in the BoM.

Include Paper Documentation—Check to include paper documentation in the BoM.

Include CD Documentation—Check to include CD documentation in the BoM.

Hide Bom/price discount—Check to hide the global discount in the Unit Price column of the BoM.
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e Dimension—Type the network size in pixels.
e Background color—Click to choose a color for the network background.

e Background image—Displays the JPEG or GIF filename used as a background, if any. To choose a
JPEG or GIF file as a background graphic for the network, click the down arrow and navigate to the
desired directory.

2.6.3 Editing Site Parameters

Editing the site parameters allows you to make changes to the current site configuration. A site folder in
the Project Explorer displays the interface node information. Figure 2-39 shows a site in the Project
Explorer before network analysis. Figure 2-40 shows a site in the Project Explorer after network
analysis.

Figure 2-39 Site in the Project Explorer
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Figure 2-40 Analyzed Site in the Project Explorer
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A site folder for an analyzed network design also contains the following items, many of which you can

edit:

e E, W, T—For a Line or Line+ site, two interface nodes appear in the Project Explorer under the Site
folder, labeled W (West) and E (East). For a Terminal or Terminal+ site, only one interface node

(T) appears.

e (C-Band or L-Band—Displays the supported band for the side (E, W, or T interface).

e Amplifiers—Lists the amplifiers and all related cards for each band and for each side (E, W, or T

interface).

e Add/Drop—Displays all of the add/drop and related cards for the band and side (E, W, or T

interface).

¢ Site Type Parameters—When selected, shows the site functionality and type in the Properties pane.

e Band Parameters—When selected, shows the output power in the Properties pane.

e (Client—Lists the client cards.

Use the following procedure to edit site parameters. To delete a site, see

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step2  Click the desired Site folder. The site parameters appear in the Properties pane.
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Step3  Complete the following to modify the site parameters in the Properties pane, as needed:

e Name—Enter the desired site name.

e Position—Enter the desired site pixel position; for example, an entry of 0,0 positions the Site icon
in the upper left corner of the NtView <Name> tab.

¢ Structure—Choose the structure type from the drop-down list:

— Line—Two pairs of fibers are terminated at the node.

— Terminal—A single pair of fibers is terminated at the node.

— Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased
when an MMU card (topology upgrade) is installed. This node is ready to scale to become a
multi-degree node once MMUSs are installed in this node.

— Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be
increased in if an MMU card (topology upgrade) is installed. This node is ready to scale to
become a multi-degree node once MMUs are installed in this node.

The following structure edits are allowed:

- Line to Line+

— Line+ to Line

— Terminal to Terminal+

— Terminal+ to Terminal

To make any other structure change (such as changing from Line to Terminal), you must delete and
reinsert the site.

e MTTR (hours)—Enter the mean time to repair (MTTR) for all sites in the network. This will apply
to every site in the network. If you change the MTTR value after creating sites, the new value will
only apply to sites you create after the change.

e Maintenance Center—Choose the name of the maintenance center from the drop-down list. To
create a maintenance center, see the “2.6.5 Creating a Maintenance Center” section on page 2-73.

e [P Address—Type the IP address of the node.

¢ Shelf Config—Choose the shelf configuration type from the drop-down list:

— Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards
(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. For this
option, Multi-Shelf Integrated Switch Cards (MS-ISC) are used to support the multishelf
configuration.

— Multi Shelf External Switch—All the MSTP optical card (OADMs and amplifiers) reside in
different shelves connected by a LAN. The LAN is implemented with switches external to the
MSTP shelves. For this option, two external Ethernet switch units are used to support the
multishelf configuration.

- Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same
shelf. For this option, multishelf management is not supported; every shelf is managed as an
independent shelf.

¢ Node Protection—Choose the node protection type from the drop-down list: Same Shelf or
Separated Shelves.

¢ DCC Shelves Management—When checked, indicates that a TXP(P)_MR_2.5G card is in Slot 12
on each shelf at each site.
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e TXP/MXP OSMINE placement—When checked, indicates that the transponder/muxponder cards
are placed in the shelves according to OSMINE placement rules.

e Hybrid MSTP/MSPP Node—When checked, indicates that all the nodes are configured as hybrid
MSTP/MSPP nodes.

e Max Number of Shelves/Bay—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves
(that equip optical cards or transponder/muxponder cards) that can be placed in each rack in the site
when generating the site layout.

¢ Functionality—Choose the site functionality from the drop-down list. Table 2-24 summarizes the
site design rules. The site icon changes depending on the functionality. For a description of the site
icons, see Appendix A, “GUI Information and Shortcuts.”

Auto—Allows the highest degree of flexibility in creating the network. Cisco MetroPlanner
generates a design for the site with the lowest possible cost given the other constraints.

Pass Through—Indicates that no equipment will be located at this site.
Line amplifier—Prevents any add/drop traffic at this site.

OSC site—Indicates that site is designated for network communication, providing the
possibility to access the optical service channel (OSC) for management of the MSTP network.
By default, no amplifiers are included in this site. However, if Cisco MetroPlanner determines
that an amplifier is required in the network, it can automatically place it at this location.
Cisco MetroPlanner allows you to set (force) preamplifier and booster amplifiers for each
direction on a OSC Site node.

Add/Drop—Indicates that this site has add/drop capability. Only point-to-point and P-ring
circuits can be added/dropped at this site.

Hub—Indicates that this site is equipped with filters for adding and dropping all the channels
(on both West and East sides). All express paths are open in hub configurations.

Gain equalizer—Indicates that this site uses WSS cards to control the generated tilt and extend
unregenerated distances. The site is realized as an ROADM site without demultiplexer cards.

R-OADM—Indicates that this site supports Any-to-Any and also Fixed (point-to-point and
P-ring) traffic types.

¢ Type—Choose the site type from the drop-down list (see Table 2-24):

S

Auto—Allows the highest degree of flexibility in creating the network. Cisco MetroPlanner
generates a design for the site with the lowest possible cost given the other set of constraints.

Glass Through—Indicates a low-priority amplification site.
Line—Indicates a high-priority amplification site.

OADM—Indicates that it is a site with add/drop channels using discrete channel filters (1, 2,
4-ch 1, 4-band).

32-WSS—Indicates that it is a site equipped with 32DMX or 32DMX-O. This option allows you
to force the use of specific ROADM units.

Note  32-WSS is available as choice in system release 7.0.x only.

Mux/Demux—Indicates that this is a full multiplexer/demultiplexer (FMD) site that adds and
drops all channels on both sides using the 32MUX-O and 32DMX-O cards. Optical bypass is
allowed.
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¢ Anti ASE—Choose Yes to configure the site so that all the express channels on the site are optically
dropped and reinserted. In addition, all the patchcords between the West and East sections are
removed. Choose Auto to allow Cisco MetroPlanner to decide if the site should be configured as
anti-amplified spontaneous emissions (Anti-ASE). See Table 2-24 for a summary of the site design
rules.

Table 2-24 Site Design Rules

C-Band C-Band C-Band L-Band
32/16 Ch. |8 Ch. 64 Ch. 32 Ch.
Structure Functionality Type Card Options 100 GHz 100 GHz 50 GHz 100 GHz
Line Pass Through — — Yes Yes Yes Yes
Line amplifier Line amplifier — Yes Yes Yes Yes
Glass Through — Yes Yes Yes Yes
OSC Site — — Yes Yes Yes Yes
Add/Drop OADM OADM cards Yes Yes No No
(Anti-ASE)
Mux/Demux — Yes Yes No No
Hub Mux/Demux — Yes Yes No No
WSS 32DMX-O Yes Yes Yes No
32DMX Yes Yes Yes Yes
Gain equalizer WSS 32DMX Yes No Yes Yes
ROADM WSS 32DMX-0O Yes No Yes No
32DMX Yes No Yes Yes
Line+ ROADM WSS 32DMX-0O Yes No No No
32DMX Yes No No Yes
Hub WSS 32DMX-0O Yes No No No
32DMX Yes No No Yes
Terminal Add/Drop OADM OADM cards Yes Yes No No
(Anti-ASE)
Mux/Demux — Yes Yes No No
ROADM WSS 32DMX-0O Yes Yes Yes No
32DMX Yes Yes Yes Yes
Terminal+ |ROADM WSS 32DMX-0O Yes No No No
32DMX Yes No No Yes
Step4  To modify the band parameters, click C-Band or L-Band in the Project Explorer for the desired site
interface. In the Properties pane, enter the desired Output power.
Step5  To modify amplifier parameters, click C-Band Amplifiers or L-Band Amplifiers in the Project
Explorer for the desired site interface. Choosing a value other than Auto will force a setting on the unit.
For more information, see the “1.6 Auto, Forced, and Locked Parameters” section on page 1-10.
a. In the Properties pane From Fibre area, complete the following as needed:
Cisco MetroPlanner DWDM Operations Guide, R7.0.1
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Step 6

PRE—Choose the desired preamplifier from the drop-down list (None, Auto,
OPT-PRE [C-band], or OPT-AMP-L [L-band]).

DCU 1/2—Choose the desired DCU from the drop-down lists.
Attenuator—Choose the desired attenuator from the drop-down list.
Output power—Enter the desired output power.

Tilt—Enter the desired tilt value.

Attenuator—Choose the attenuator from the drop-down list.

b. In the Properties pane To Fibre area, complete the following as needed:

BST—Choose the desired booster from the drop-down list (None, Auto, OPT-BST [C-band],
OPT-BST-E [C-band], OPT-AMP-L [L-band], or OPT-BST-L [L-band]).

DCU 1/2—Choose the desired DCU from the drop-down lists.
Output power—Enter the desired output power.

Tilt—Enter the desired tilt value.

c. In the Properties pane General area, choose the OSC from the drop-down list (OSC-CSM or
OSCM).

To modify OADM parameters, click Add/Drop in the Project Explorer for the desired site interface. In
the Properties pane, complete the following as needed:

¢ In the Line/OADM area, choose the desired attenuator from the drop-down list.

e In the Mux/Demux WSS area, complete the following as needed:

— Patch Panel—Choose the patch panel from this drop-down list.

— Demux—Choose the demultiplexer from this drop-down list.

— Mux—Choose the multiplexer from this drop-down list.

2.6.4 Deleting Sites

Step 1

Step 2

Step 3

Step 4

Use the following procedure to delete sites from a network. You can delete a site if the site is in the
Unlocked state and does not have a traffic demand set up on it. You can delete sites from a network in
the Design state only.

Verify that the site is in the Unlocked state in the Project Explorer pane. For more information, see the
“2.7.4 Unlocking Parameters in the Network Design” section on page 2-88.

Delete any traffic demands. For more information, see the “2.6.9 Deleting a Traffic Demand” section
on page 2-77.

On the NtView <Name> tab, click the Site icon and choose Delete from the Tasks Pane. For more
information about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.” As
an alternative, you can click Delete in the Tasks Pane. A confirmation message appears, asking you to
confirm the deletion of the site.

Click Yes to delete the site.
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2.6.5 Creating a Maintenance Center

Step 1
Step 2

Step 3
Step 4

Step 5

Use the following procedure to add maintenance centers that will supply your network with spare parts
in the event of a failure. This feature helps your customer determine the quantity of spares that should
be purchased, depending on the number of maintenance centers and their availability. Maintenance
centers appear in the Maintenance Center folder under a site in the Project Explorer.

In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Scroll down the Project Explorer, right-click the Maintenance Center folder, and choose New
Maintenance Center from the shortcut menu.

Highlight the new maintenance center in the Project Explorer.
In the Properties pane, complete the following as needed:

¢ Confidence Level—Choose the percentage that represents the required confidence level for finding
needed spare parts in the maintenance center: 50, 75, 95, or 99 percent.

e Restocking time (days)—Enter the time (including transportation) required to restock the part in the
maintenance center.

To associate a maintenance center with a site, see the “2.6.3 Editing Site Parameters” section on
page 2-67.

2.6.6 Editing a Point-to-Point Demand

Step 1
Step 2

Step 3

Use the following procedure to edit a point-to-point demand:

In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

In the Project Explorer, right-click the point-to-point demand and choose Edit from the shortcut menu.
The Edit Point to Point Demand dialog box appears (Figure 2-41).

Figure 2-41 Edit Point to Point Demand Dialog Box
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Cancel

To modify the information for each channel, complete the following as needed:
e Forecast—Check to change a present channel to a forecast channels.

¢ Srv. Type—Choose the desired service type from the drop-down list. Changing the service type for
one channel automatically changes the service type for all channels.
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¢ Protection—Choose the desired protection type from the drop-down list. Changing the protection
type for one channel automatically changes the protection for all channels.

e Path—Choose W (west-to-east) or E (east-to-west) from the drop-down list.

e Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto,
Cisco MetroPlanner assigns wavelength to the channels with the lowest possible cost given the other
constraints.

¢ Optical Bypass—Choose the site for optical bypass from the drop-down menu.
e WDM Intf. Type—Choose the desired card interface type from the drop-down list.

e WDM Card Type—Choose the desired card type from the drop-down list. The available options
depend on the card interface type that is selected. Changing the card type for one channel
automatically changes the card type for all channels.

¢ Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available
options depend on the card type that is selected.

e Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The
available options depend on the card type that is selected.

Step4  To add a new channel, click the Create a new circuit icon on the right of the Edit Point to Point Demand
dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for the new channel.

Step5 To delete an existing channel, select the row and click the Remove the selected circuit icon on the right
of the Edit Point to Point Demand dialog box.

Step6  Click Ok to save the changes to the channels and close the Edit Point to Point Demand dialog box, or Cancel
to close the dialog box without saving the changes.

2.6.7 Editing a P-Ring Demand

Use the following procedure to change the distribution of services in a P-ring service demand:

Step1  In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step2  In the Project Explorer, right-click the P-ring demand and choose Edit from the shortcut menu. The Edit
P-Ring Demand dialog box appears (Figure 2-42).
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Figure 2-42 Edit P-Ring Demand Dialog Box
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Step3  Complete the following as needed in the Edit P-Ring Demand dialog box to modify the P-ring:
¢ Service Type—Choose the desired service type from the drop-down list.

e WDM Card Type—Choose the desired card type from the drop-down list. The available options
depend on the service type selected.

e WDM Interface—Choose the desired card interface type from the drop-down list. The available
options depend on the card type selected.

In the Circuits area of the Edit P-Ring Demand dialog box, complete the following as needed:
¢ Ring—(Display only) Displays the name of the P-ring.
e Forecast—Check to change the present channels to forecast channels.

e Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto,
Cisco MetroPlanner assigns wavelengths to the channels with the lowest possible cost given the
other constraints.

In the Sections area of the Edit P-Ring Demand dialog box, complete the following as needed:
e Src—(Display only) Displays the source site name for a section.
e Dst—(Display only) Displays the destination site name for a section.

e Opt. Bypass—Choose the sites from the drop-down list where the channels for the current demand
will be optically dropped. Only the sites between the source and destination sites along the path of
this section are available as options.

¢ Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available
options depend on the card type selected.

e Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The
available options depend on the card type selected.

Step4  To add a new P-ring channel, click the Create a new P-Ring circuit icon on the left of the Edit Point to
Point Demand dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for
the new P-Ring.

Step5  To delete an existing channel from the P-ring, select the row and click the Remove the selected P-Ring
circuit icon on the left of the Edit P-Ring Demand dialog box.
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Step 6

Click Ok to save the changes to the channels and close the Edit P-Ring Demand dialog box, or Cancel to
close the dialog box without saving the changes.

2.6.8 Editing a ROADM Demand

Use the following procedure to change the distribution of services in a ROADM service demand:

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6

Step 7

In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Right-click the ROADM traffic group and choose Edit from the shortcut menu. The Edit ROADM
Demand dialog box appears (Figure 2-43).

Figure 2-43 Edit ROADM Demand Dialog Box
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Select a traffic pattern type (Hub or Meshed) from the drop-down list. If you select Hub, the First Site
drop-down button becomes available. If you selected Meshed, go to Step 5.

For Hub traffic types, select the originating site from the First Site drop-down list.

Select a connectivity type from the Connectivity type drop-down list. The choices are Protected,
Unprotected Minimum Hop, Unprotected Optimum Path, and Unprotected Subnet. Refer to the
“1.5.3 ROADM Traffic Demands” section on page 1-10 for more information about the connectivity

type choices.

In the Service types pane, check the boxes for one or more client service types for the ROADM demand.
The client interfaces that support each service type appear in the right pane.

To further refine the client interfaces, complete the following options for each row in the right pane.

Check boxes in gray are not available for the client interface selection.

e Yes/No—Check to select this card to implement the service type.

¢ Client Interface—Displays the card type for the selected service type.

e Y-Cable—Check to select Y-cable protection if the connectivity type is Protected.

¢ 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.
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e Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

¢ Supported Service—Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default,
Cisco MetroPlanner checks the best client interface to support each service.

Click Ok to save the changes to the demand.

2.6.9 Deleting a Traffic Demand

Step 1
Step 2

Step 3

A traffic demand must be in the Unlocked state before you can delete it. Use the following procedure to

delete a traffic demand:

In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Verify that the demand is in the Unlocked state. For more information, see the “2.7.4 Unlocking
Parameters in the Network Design” section on page 2-88.

Right-click the demand that you want to delete in the Project Explorer and choose Delete from the
shortcut menu. As an alternative, you can click Delete in the Tasks Pane.

2.6.10 Editing Fiber Span, Pair, and Fiber Parameters

Using the Properties pane, you can manage a fiber span, a fiber pair, and individual fibers. A fiber pair
consists of two different fibers (clockwise and counter-clockwise). Table 2-25 lists the properties that
you can modify for a fiber span, pair, or fiber.

Table 2-25 Editable Fiber Properties

Property Fiber Span Fiber Pair Fiber
Name Yes Yes No
Ageing loss Yes No No
Ageing factor Yes No No
Fiber type Yes Yes No
Fiber length Yes Yes Yes
Length-based loss Yes Yes Yes
Connector loss (per site) Yes Yes Yes
Absolute loss without connectors | Yes Yes No
CD factor Yes Yes No
PMD factor Yes Yes No
Loss Yes Yes Yes

Use the following procedure to edit fiber span, pair, and fiber parameters:
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Step 1
Step 2

Step 3

Step 4

In the Project Explorer, right-click the Fibers folder and choose Expand from the shortcut menu.

In the Project Explorer tree, click one of the following. The options available for editing in the Properties
pane change depending on your selection.

e To edit a fiber span, click the duct identifier.
e To edit a fiber pair, click the fiber pair identifier.
e To edit an individual fiber, click the fiber identifier.

In the Properties pane, edit the following parameters, as necessary. See Table 2-25 for the properties that
you can change for a fiber span, fiber pair, or individual fiber.

e Name—Type the desired name for the fiber span, pair, or fiber.

e Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you
set the ageing factor, you do not need to set the ageing loss.

e Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

¢ Type—Choose the type of fiber for each span in the network.

e Length—Type the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

e Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave
unchecked if fiber loss is derived from the span length.

e Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.
e Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

e Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the
length. In the Length Based model, this value is calculated automatically.

e CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is
defined at 1545.3 nm; L band is defined at 1590.4 nm.

e PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km.

e Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in
the network. The fiber loss factor is always entered in dB/km.

As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties
pane:

¢ Loss BOL—(Display only) Displays the total loss beginning of life (BOL) calculation.

~

Note BOL is also referred to as SOL.

e Loss EOL—(Display only) Displays the total loss EOL calculation.
e CD—(Display only) Displays the total chromatic dispersion.
e PMD—(Display only) Displays the total polarization mode dispersion.
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2.6.11 Editing Fiber Spans, Pairs, and Fibers Using the Fibres Dialog

Step 1

The Fibres Dialog lists all fiber spans, pairs, and fibers in the network. Use the following procedure to
view and edit fiber parameters from the Fibres Dialog box.

In the Project Explorer tree, right-click the Fibres folder in the desired network and choose Fibres
Dialog from the shortcut menu. The Fibres Dialog appears (Figure 2-44).

Figure 2-44 Fibres Dialog
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Table 2-26 describes the columns on the Fibres Dialog.

Table 2-26 Fibres Dialog Columns

Column Description

Name Displays the name of the fiber span (Duct), pair (Couple), or fiber. Click the plus (+)
sign by a Duct name to expand the list and show the Couple names. Click the plus
(+) sign by a Couple name to expand the list and show the individual fiber names.

Src. Displays the name of the source site or interface for the fiber span, pair, or fiber.

Dst. Displays the name of the destination site or interface for the fiber span, pair, or fiber.

Type Displays the type of fiber for each span in the network: G652-SMF, E-LEAF, or True
Wave.

Length Displays the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

Loss SOL Displays the total loss start of life (SOL) calculation.

Loss EOL Displays the total loss end of life (EOL) calculation.

CD C-Band Displays the total chromatic dispersion for the C-band.
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Table 2-26 Fibres Dialog Columns (continued)

Column Description

CD L-Band Displays the total chromatic dispersion for the L-band.
PMD Displays the total polarization mode dispersion (PMD).
QD C-Band Displays the secondary order dispersion for C-band.
QD L-Band Displays the secondary order dispersion for L-band.
RD Displays the random dispersion value.

Step2  To edit a fiber span, pair, or fiber, click the desired item in the Fibres Dialog. The Properties pane in the
right area of the Fibres Dialog displays the properties for the selected item.

Step3  Inthe Properties pane, edit the following parameters, as necessary. See Table 2-25 for the properties that
you can change for a fiber span, fiber pair, or individual fiber.

Name—Type the desired name for the fiber span, pair, or fiber.

Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you
set the ageing factor, you do not need to set the ageing loss.

Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

Type—Choose the type of fiber for each span in the network: G652-SMF, E-LEAF, or True Wave.

Length—Type the span length. The displayed unit of measure is retrieved from the
Span Measurements Units field.

Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave
unchecked if fiber loss is derived from the span length.

Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.
Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the
length. In the Length Based model, this value is calculated automatically.

CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is
defined at 1545.3 nm; L band is defined at 1590.4 nm.

PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km.

Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in
the network. The fiber loss factor is always entered in dB/km.

Cisco MetroPlanner updates the Fibres Dialog box with the new value.

Step4  As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties
pane:

Loss BOL—(Display only) Displays the total loss beginning of life (BOL) calculation.

A

Note BOL is also referred to as SOL.
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¢ Loss EOL—(Display only) Displays the total loss EOL calculation.

e CD—(Display only) Displays the total chromatic dispersion.

e PMD—(Display only) Displays the total polarization mode dispersion.
Click Ok.

2.6.12 Exporting the Fiber Spans, Pairs, and Fibers in a Network

Step 1

Step 2
Step 3

Use the following procedure to export all spans, pairs, and single fibers in a network in XLS format:

In the Project Explorer tree, right-click the Fibres folder in the desired network and choose Fibres
Dialog from the shortcut menu. The Fibres Dialog appears (Figure 2-44).

Click Export. The Fibres Export dialog box appears.
Navigate to the desired directory, type the XLS filename, and click Save.

2.6.13 Deleting a Fiber Span

Step 1
Step 2

Step 3

Use the following procedure to delete a fiber span from the network design:

In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

In the Project Explorer, right-click the duct that you want to delete and choose Delete from the shortcut
menu. As an alternative, you can click Delete in the Tasks Pane.

Click Yes to confirm the fiber deletion.

2.6.14 Arranging Sites

Sites can be arranged into four different configurations. Use the following procedure to arrange the sites
into a configuration or to move all of the sites so that they appear in the Cisco MetroPlanner window:

Step 1 Click the NtView <Name> tab.
Step2  Click the Arrange Sites drop-down list, and choose one of the following:
~
Note  All shapes are approximations.
e Fit to visible rectangle view—Zooms to display all sites in the NtView <Name> tab.
e Arrange to an ellipse—Rearranges all sites in an ellipse form (Figure 2-45).
Cisco MetroPlanner DWDM Operations Guide, R7.0.1
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Figure 2-45 Ellipse Shape
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e Arrange to a square—Rearranges all sites in a square form so that the sites appear clockwise around
the square (Figure 2-46). To complete a full square, this arrangement requires at least four sites.
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Figure 2-46 Square Shape
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Arrange to a snake—Rearranges all sites so that they cross the NtView <Name> tab from right to
left and then left to right in a serpentine, linear format (Figure 2-47).
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Figure 2-47 Snake Shape
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e Arrange to a double ring—Rearranges the sites into a dual ring format (Figure 2-48).
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Figure 2-48 Double Ring Shape
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2.7 Managing the Network Design

After creating and analyzing a network design, you must prepare the design for installation at a customer
site. After a network has been installed, you can reanalyze to correct any problems.

Network designs have several possible states:

Design—The initial state for any new network design. You can add, delete, or change any aspect of
the network design. In the Design state, no locks exist. After analyzing a design, you can put it back
into the Design state to modify it by choosing Design in the Tasks Pane.

Design-Analyzed—The state of the network design after you run the network analyzer. All reports
are available and updated. You cannot change any aspect of the network design. You can modify
the BoM, such as changing global discounts and spare parts. You can return to the Design state after
analyzing the network by choosing Design in the Tasks Pane.

Copy—A copy of a network. You can create a copy of a network in any state. A copy is useful for
testing different design options. You can copy a network before or after analyzing it. A copied
network inherits the set of project options defined in the original network. For more information,
see the “2.7.1 Creating a Copy of the Network” section on page 2-86.

Install—A network is initially designed with theoretical fiber values (such as loss, length, etc.).
When a network is installed in the field, you can move the network into the Install state so that you
can enter and check the real fiber parameter values. You can create an Install network from a
network in the Design-Analyzed or Upgrade-Analyzed state. A network in the Install state inherits
the set of project options defined in the analyzed network. All sites in an Install network are locked.
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You cannot modify any aspect of the network design except the span parameters and (on unlocked
sites) amplifiers. You can, however, modify the BoM. All routed circuits are fixed, and cannot be
changed while in this state. For more information, see the “2.7.2 Creating a Network in the Install
State” section on page 2-86.

e Install-Analyzed—The state of the Install network design after you run the network analyzer. All
reports are available and updated. Cisco MetroPlanner locks all sites, spans, demands, and
equipment when a network is in the Install-Analyzed state.

e Upgrade—During network design, you define a number of the channels to be implemented at the
present time and a number of channels to be implemented in the future (forecast). After installing
the network, you might decide to implement the forecast circuits. To do this, you create an Upgrade
network and then select the forecast or traffic demand services that you want to implement. You can
create an Upgrade network from a network in the Design-Analyzed or Install-Analyzed state. You
can unlock specified parameters to alter the design to include forecasted channels and traffic
demands. A network in the Upgrade state inherits the set of project options defined in the analyzed
network. For more information, see the “2.7.3 Creating an Upgrade Network™ section on page 2-87.

e Upgrade-Analyzed—The state of the Upgrade network design after you run the network analyzer.
All reports are available and updated. Cisco MetroPlanner locks all sites, spans, demands, and
equipment when a network is in the Upgrade state.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “2.1.1 Opening a Project” section on page 2-3 and the “2.1.2 Loading and Unloading Networks”
section on page 2-3.

2.1.1 Creating a Copy of the Network

To create a copy of a network in any state, right-click the network and choose Copy from the shortcut
menu. A new copy appears in the Network Mgmt Tree tab.

2.1.2 Creating a Network in the Install State

Step 1
Step 2
Step 3

Step 4

Step 5

Use the following procedure to create a network in the Install state:

If the network is not analyzed, complete the “2.4 Analyzing the Network™ section on page 2-37.
Click the Networks Mgmt Tree tab.

Right-click the network and choose Install from the shortcut menu. A new network appears in the
Networks Mgmt Tree in the Install state. All results from the analyzed network are imported into the
Install network and are placed in the Locked mode.

Make the necessary changes to the Install network. You can edit the following fiber parameters: fiber
loss value, fiber CD, fiber PMD, and fiber length. See the “2.6.10 Editing Fiber Span, Pair, and Fiber
Parameters” section on page 2-77. Cisco MetroPlanner also allows you to unlock site parameters for
modification. To change site parameters, see the “2.6.3 Editing Site Parameters” section on page 2-67.

In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The
MetroPlanner Analyzer status window appears to indicate the progress. As an alternative, click Analyze
in the Tasks Pane. The Cisco MetroPlanner analysis status bar indicates when the network analysis is
complete. The network now appears in the Install-Analyzed state.
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Note  If you have changed parameters that are inconsistent with the present network layout (for
example, if you set an output tilt value that the amplifier cannot reach), during network analysis
an error message on the Analyzer Messages pane identifies which parameter is causing the
problem. Warning and error messages help you identify problems with your current design. For
a list of all system messages, see Appendix C, “System Messages.”

Step6  When you have analyzed the network and are satisfied with the results, import the new generated
installation parameters to each site of the network. For more information, see the “2.5.2 Saving the NE
Update File” section on page 2-40.

2.1.3 Creating an Upgrade Network

In an Upgrade network, you can perform the following tasks:
e Modify the fiber span properties (such as length, dispersion, PMD coefficient, excess losses, and
aging).
e Add or delete traffic.
¢ Convert forecasted traffic to present traffic.
e Convert ROADM traffic to present traffic.
e Modify the type of a node.

e Force the presence or the absence of a card or a module (this includes amplifiers, OSC modules,
OADM cards, and DCU modules).

In an Upgrade network, you can force certain installation parameters:
e Amplifier per-channel output power setpoint
e Amplifier output tilt setpoint
e OADM card aggregate output power setpoint
e Full multiplexer/demultiplexer or ROADM output power setpoint
You cannot change the following parameters when in Upgrade state:
e Node input channel fail threshold
¢ Node OSC channel fail threshold
e Preamplifier input power threshold
e OADM card aggregate input power setpoint
¢ Full muxponder/demuxponder or ROADM input power setpoint
e Channels drop power

Use the following procedure to put a network in the Upgrade state:

Step 1 If the network is not analyzed, complete the “2.4 Analyzing the Network™ section on page 2-37.
Step2  Click the Networks Mgmt Tree tab.
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Step 3

Step 4

Step 5

Right-click the analyzed network and choose Upgrade from the shortcut menu. A new Upgrade network
appears in the Networks Mgmt Tree tab. All results from the analyzed network are imported into the
Upgrade network.

Make the necessary changes to the Upgrade network. For more information, see the “2.6.10 Editing
Fiber Span, Pair, and Fiber Parameters” section on page 2-77 and the “2.6.3 Editing Site Parameters”
section on page 2-67.

In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The
MetroPlanner Analyzer status window appears to indicate the progress. As an alternative, click Analyze
in the Tasks Pane in any view. The Cisco MetroPlanner analysis status bar indicates when the network
analysis is complete. The network now appears in the Upgrade-Analyzed state.

N

Note  If you have changed parameters that are inconsistent with the present network layout (for
example, if you set an output tilt value that the amplifier cannot reach), during network analysis
an error message on the Analyzer Messages pane identifies which parameter is causing the
problem. Warning and error messages help you identify problems with your current design. For
a list of all system messages, see Appendix C, “System Messages.”

2.1.4 Unlocking Parameters in the Network Design

The Locked state occurs when you did not set (force) any value for a parameter and instead chose Auto.
During network analysis, Cisco MetroPlanner assigns a value for each parameter set with Auto and puts
them in the Locked state. The Locked state indicates that the next time the network is analyzed, the
analyzer cannot change the value. Locking a site forces the presence or absence of all preamplifiers,
boosters, add/drop filters, and DCU cards required by the site/network as a result of running the analyzer
previously. Locked elements are indicated by a closed padlock icon in the Project Explorer

(Figure 2-49). For more information on the Auto, forced, and locked states, see the “1.6 Auto, Forced,
and Locked Parameters” section on page 1-10.

Figure 2-49 Locked Sites in the Project Explorer View
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To unlock network components to edit parameters, right-click the desired element in the Project
Explorer and choose Unlock from the shortcut menu.

2.1.5 Creating a JPEG of the Network Design

Step 1

Use the following procedure to create a snapshot of your network design in JPEG format:

Click the NtView <Name> tab.
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Complete the “2.6.14 Arranging Sites” section on page 2-81 as necessary so that the sites in the network
appear in the tab in the desired arrangement.

Click the Save network view image icon in the toolbar.
In the Save network view image dialog box, navigate to the desired directory.

Enter the file name in the File Name field and click Save.

2.8 Generating a BoM

You can generate a BoM when a network is in the Install or Upgrade state, or after you have successfully
analyzed your network design. The price database selected during project creation is used to generate
the BoM.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See
the “2.1.1 Opening a Project” section on page 2-3 and the “2.1.2 Loading and Unloading Networks”
section on page 2-3.

2.8.1 Viewing BoM Report Totals

Step 1
Step 2

Step 3

Step 4

Use the following procedure to view the BoM report totals:

Click the Networks Mgmt Tree tab and click the network.

In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. As an alternative, you can
access this report by choosing Bill of Materials from the Reports folder in the Project Explorer tree.

The upper section of the BoM tab (in the Net view, Site view, and Spare subtabs) displays the following
information:

¢ BoM total discounted—Displays the price for the overall network (without spare parts) for each item
in the BoM. If Use global discount is checked, the total includes the discount from the Global
discount percentage field.

e Spare total discounted—Displays the price for all of the recommended spare parts in all of the
maintenance centers for the overall network. It is the sum of each spare item using the discounted
price. The total appears after you check the Spare Part Report check box.

e BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total
discounted price.

e Price List—Displays the name of the price list database selected for the project.
e Price List last update—Displays the date that the selected price list was last updated.

e Currency—Displays the value of the currency used for each of the price values as specified within
the selected price list database.

To use the Multishelf Management Integrated Kit bundle when generating the BoM instead of the single
items, check Use MSM bundle.

Check Spare Part Report to include the spare parts in the report totals.

N

Note  You can only check the Spare Part Report check box if the network is in Design mode.
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Step5  The Global discount percentage field shows the percentage from the Global Discount Percentage option
in the Default Project Options window. To change the global discount for the entire network, check
Use global discount and enter a new global discount in the form of a percentage in the Global discount
percentage field. The global discount is applied to all components in the BoM and will overwrite any

discount specified in the Global Price List.

2.8.2 Generating a Network BoM

Use the following procedure to generate a BoM for the network:

Step 1 Click the Networks Mgmt Tree tab and click the network.

In the Tasks Pane, click Bill of Material. The Bill of Material tab (Figure 2-50) appears. The Net View
subtab is selected by default. Items that are not found appear in yellow in the BOM.

Step 2

Figure 2-50 Bill of Material Tab, Net View Subtab
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Table 2-27 describes the Net view subtab columns. See the “2.8.1 Viewing BoM Report Totals” section
on page 2-89 for a description of the data, check boxes, and fields at the top of the window.
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Table 2-27 BoM Net View Columns

Column Label Description

Product ID Displays the ordering code used to order the BoM from Cisco.
Description Displays a description of the product.

Quantity Displays the number of specific products in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will

display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global
Discount Percentage field. If you leave the field blank, the field displays the
default value from the Price List database.

Total price Displays the total price of the products before applying the discount.
Discounted Total Displays the total price of the products after applying the discount.

Price

Site # Displays the number of products to be assigned to a particular site. The number

of Site columns is the same as the number of sites in the network.

Step3  To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.3 Generating a Site BoM

A site BoM lists all of the hardware and software parts required for the system to work as designed at a
given site. Use the following procedure to generate a BoM for a site:

Step 1 Click the NtView <Name> tab and click the site.

Step2  Inthe Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-51). Items
that do not appear in the price list appear in red.
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Figure 2-51 Bill of Material Tab, Site View Subtab
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Table 2-28 describes the Site view subtab columns. See the “2.8.1 Viewing BoM Report Totals” section
on page 2-89 for a description of the data, check boxes, and fields at the top of the window.

Table 2-28 BoM Site View Columns

Column Label

Description

Name

Displays the site name. Click the plus (+) sign to expand the site and display
the categories. Click the plus (+) sign to expand each category to view the
items in the BoM.

Product ID

Displays the ordering code used to order the BoM from Cisco.

Quantity

Displays the number of that specific item in the BoM.

Unit price

Displays the price for each unit. If the price does not appear, Invalid will
display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount

Displays the per-unit discount amount that you assigned in the Global
Discount Percentage field. If you leave the field blank, the field displays the
default value from the Price List database.
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Table 2-28 BoM Site View Columns (continued)

Column Label Description

Total Price Displays the total price of the products before applying the discount.
Discounted Total Displays the total price of the products after applying the discount.
Price

Step3  To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.4 Generating a Spare Parts Report

After you generate the BoM, use the following procedure to determine the spare parts required by the
network. If the network is in the Upgrade state, the report includes the parts required to support the
implemented services and the new additional present services. To generate a spare parts report, you must
associate a site with a maintenance center before network analysis. For more information, see the
“2.6.3 Editing Site Parameters” section on page 2-67.

Step 1 Click the Networks Mgmt Tree tab and click the network.
Step2 In the Tasks Pane, click Bill of Material. Click the Spare subtab (Figure 2-52).
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Figure 2-52 Bill of Material Tab, Spare Subtab
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Table 2-29 describes the Spare subtab columns. See the “2.8.1 Viewing BoM Report Totals” section on
page 2-89 for a description of the data, check boxes, and fields at the top of the window.

Table 2-29 BoM Spare Subtab Columns

Column Label Description

Name Displays the name of the item at the site. Right-click the maintenance center
and choose Expand All from the shortcut menu to view all spare parts.

Product ID Displays the ordering code used to order the BoM from Cisco.

Quantity Displays the number of specific items in the BoM.

Unit price Displays the price for each unit. If the price does not appear, Invalid will

display. This occurs when the price list reports “NaN” (Not a Number) for the
item because the price list has never been updated. Invalid items appear in the
list in red. Items that have not been updated from CCO appear in yellow.

Unit Discount Displays the per-unit discount amount that you assigned in the Global
Discount Percentage field. If you leave the field blank, the field displays the
default value from the Price List database.

Total Price Displays the total price of the parts before applying the discount.
Discounted Total Displays the total price of the parts after applying the discount.
Price
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To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.5 Exporting a BoM

Step 1
Step 2
Step 3
Step 4

Use the following procedure to export the BoM to an external file in XML, Excel spreadsheet, HTML,
or text format:

Click the Networks Mgmt Tree tab and click the network.
In the Tasks Pane, click Bill of Material. The Bill of Material tab appears.
Click Export. The BoM export dialog box appears.

In the BoM export dialog box, type the name of the file, choose the file type (.xls and .html) from the
drop-down list, and navigate to the desired folder. Click Save.

2.9 Managing the Price List

A price list is defined for each project and is used to generate a BoM. Cisco MetroPlanner can manage
multiple price lists. You can even change a project price list after a project has been established. The
Master Price list is the Global Price List in US dollars. You can download new price lists from Cisco
Connection Online (CCO).

Only the selected price value is saved with a project; the actual price database is not saved with the
project. When opening a saved project (for example, a project received from another designer), the
associated price database might not be available. If this is the case, Cisco MetroPlanner notifies you that
the Master Price list will be used.

To save memory, Cisco MetroPlanner automatically loads only the price list selected for the current
project.

2.9.1 Creating a New Price List

Use the following procedure to download a price list from CCO. You can download price lists from CCO
if no projects are currently open.

Step1  If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.
Step2  From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53).
Cisco MetroPlanner DWDM Operations Guide, R7.0.1
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Step 3

Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Step 10

Figure 2-53 Price Manager Dialog Box
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In the Price Manager dialog box, right click PriceDBManager and choose New Price DB from the
shortcut menu.

In the Create a New Price DB dialog box, enter the price list name.
From the drop-down list, choose the desired CCO price list.

Click OK.

Click OK to update from CCO.

In the CCO User Name/Password dialog box, type your user name and password, and click OK.
Cisco MetroPlanner downloads the CCO price list.

When the update is complete, click OK to close the confirmation dialog box. The new price list appears
in the PriceDBManager tree.

Click Close to close the Price Manager dialog box.

2.9.2 Viewing a Price List

Step 1

Use the following procedure to view and filter a price list:

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53 on
page 2-96).
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The PriceDB Manager tree lists all of the created price lists. To save memory, Cisco MetroPlanner
automatically loads only the price list selected for the current project (unless the user requests
otherwise). An L indicates that the price list is loaded in memory and is available. A U indicates that a
price list is currently not loaded in memory and is not available.

Step2  Toload or unload a price list, right-click a price list and choose Load or Unload from the shortcut menu.

Step3  Click PriceList under the desired price list identifier in the PriceDBManager tree. The list displays in
the right pane of the Price Manager dialog box. The properties of the price list appear in the bottom left
corner of the Price Manager dialog box:

e Lastupdate—Indicates the date of the last download from CCO for this price list. If Never appears,
this indicates that the user created a price list without downloading from CCO.
e Updated by—Identifies the way in which the price list was updated.
The price list displays the following columns:
e Price List ID—For internal use.
e Major Parent ID—Lists the platform.
e Minor Parent ID—Lists the equipment type.
e Product ID—Identifies the ordering code for the specific unit.
e Description—Provides detail about the item.
e Service Category—For future use.
e List Price—Indicates the price of the item. If NaN (Not a Number) appears in the field, the list has
not been updated.
e Major ID—For internal use.
e Minor ID— For internal use.
e Update Status—Identifies how the last update was made to an item:
— None—Indicates that the price list has never been updated.
— local_file—Indicates that the price list has been updated from a local file.
— cco—Indicates that the price list has been updated from CCO.
— user—Indicates that the price list has been manually updated by the user who directly edited the
price list. The user can modify the Discount field.
e Discount—If a discount applies, identifies the discount percentage. To modify this field, enter the
new percentage.

Step4  To search for a specific item in a price list, type the desired item in the Search field at the top of the list.
As you type, Cisco MetroPlanner filters the list items to match your search entry. To choose Search
options, click the Search Tool icon to the left of the Search field and choose one of the following:

¢ Column name—Searches only the specified column for the search string. The All option searches
all columns.
e (ase sensitive—Matches the case of the search string.
e (ase insensitive—Disregards the case of the search string.
e Match from start—Searches only for the search string if it appears at the beginning of column text.
e Match any where—Searches for the search string if it appears anywhere in the price list.
Step5  To sort the items in the price list, click on a column to sort by that column.
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Step 6

Click Close to close the Price Manager dialog box.

2.9.3 Loading and Unloading Price Lists

Step 1

Step 2

To save memory, Cisco MetroPlanner automatically loads only the price list selected for the current
project. An “L” by a price list in the Price Manager dialog box indicates that the price list is loaded; a
“U” in the Price Manager dialog box indicates that the price list is not loaded. Use the following
procedure to load or unload price lists in Cisco MetroPlanner:

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53 on
page 2-96).

Right-click the price list and choose Load or Unload from the shortcut menu.

2.9.4 Updating a Price List from CCO

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Use the following procedure to update a specified price list from CCO or from a local file. You can also
update all price lists, even the lists that are not currently loaded. You can update a price lists from CCO
if no projects are currently open.

If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53 on
page 2-96).

Right-click the desired price list identifier in the PriceDBManager tree and choose Expand from the
shortcut menu.

Right-click the desired price list in the expanded tree and choose UpdateFromCCO from the shortcut
menu.

In the Update from CCO dialog box, choose Update single price list to download data for the specified
list or Update all price lists to download the latest data for all price lists.

In the CCO User Name/Password dialog box, type your user name and password and click OK.
Cisco MetroPlanner downloads the price list.

When the update is complete, click OK to close the confirmation dialog box.

Click Close to close the Price Manager dialog box.
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2.9.5 Copying a Price List

Step 1
Step 2

Step 3
Step 4

Step 5

Use the following procedure to create a new price list by copying from an existing one. The new price
list will have all of the attributes and values of the original price list (such as Updated By, Last Update,
unit price, discounts, etc.). You can copy a price list if no projects are currently open.

If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53 on
page 2-96).

Right-click the desired price list in the PriceDBManager tree and choose Copy from the shortcut menu.

Type the name for the new price list and click Ok. The new price list appears in the PriceDBManager
tree.

Click Close to close the Price Manager dialog box.

2.9.6 Deleting a Price List

Step 1
Step 2

Step 3
Step 4

Use the following procedure to delete a price list. You cannot delete the Master Price List or a price list
that is in use by a project. You can delete a price list if no projects are currently open.

If a project is open, close the project. See the “2.1.5 Closing a Project” section on page 2-6.

From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53 on
page 2-96).

Right-click the desired price list in the PriceDBManager tree and choose Delete from the shortcut menu.

Click Close to close the Price Manager dialog box.

2.9.7 Viewing Maintenance Contracts

Use the following procedure to view maintenance contracts:

Step1  From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-53 on
page 2-96).

Step 2 Right-click Maintenance Contracts and choose Expand from the shortcut menu.

Step 3 Click ContractsList. The Contract PID column lists the service contract identifiers for the hardware and
software parts used by Cisco MetroPlanner. The Contract Category column describes the service
programs.

Step 4 Click MapPidsContracts. The PID column lists the product identifiers. The Contracts column lists the
service contract identifier.

Step5  Click Close to close the Price Manager dialog box.

Cisco MetroPlanner DWDM Operations Guide, R7.0.1
[ December 2010 .m



Chapter2  Designing Networks with Cisco MetroPlanner |

I Managing the Price List

Cisco MetroPlanner DWDM Operations Guide, R7.0.1
m. December 2010 |



CHAPTER

Modeled Network Examples

This chapter provides examples of typical optical networks you can model using Cisco MetroPlanner.
This chapter contains the following sections:

3.1 Supported Cisco MetroPlanner Topologies, page 3-1

3.2 Bus Topologies, page 3-1

3.3 Hubbed Ring Topology, page 3-2

3.4 Meshed Topology, page 3-3

3.1 Supported Cisco MetroPlanner Topologies

Cisco MetroPlanner supports the following topologies:
e Bus (single span, point-to-point, and linear)
¢ Open (or hubbed) ring
¢ Closed (or meshed) ring

An example of each topology is given in this chapter.

3.2 Bus Topologies

Bus topologies comprise three types of topologies: single span, point-to-point, and linear.

3.2.1 Single-Span Topology

Figure 3-1 shows an example of a single-span topology. Single-span topologies are characterized by a
single span link. The single-span configuration only supports two terminal sites (full terminal or flexible
channel-count terminal) without any intermediate line amplifier or optical add/drop multiplexing
(OADM) sites.
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Figure 3-1 Single-Span Topology Example
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3.2.2 Point-to-Point Topology

Figure 3-2 shows an example of a point-to-point topology. In a point-to-point topology, all the
wavelengths are terminated at the same point in the chain. In the point-to-point configuration, no
channels are added or dropped in intermediate sites.

Figure 3-2 Point-to-Point Topology Example
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3.2.3 Linear Topology

Figure 3-3 shows an example of a linear topology. Linear configurations are characterized by the
presence of two terminal sites (full terminal or flexible channel-count terminal). Between the two
terminal sites, OADM or line amplifiers nodes can be inserted. In a linear configuration, specific
wavelengths are terminated at different points in the chain and only unprotected traffic can be
provisioned.

Figure 3-3 Linear Topology Example
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3.3 Hubbed Ring Topology

Figure 3-4 shows an example of a hubbed ring topology. In this configuration, at least one of the sites
must be a hub site, where all channels are terminated.
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Figure 3-4 Hubbed Ring Topology Example
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3.4 Meshed Topology

Figure 3-5 provides an example of a meshed ring topology. A meshed ring is characterized by the

absence of a hub node.
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Figure 3-5 Meshed Ring Topology Example
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APPENDIX A

GUI Information and Shortcuts

This appendix describes the Cisco MetroPlanner views, menus, tools, and shortcuts options. For more
information about Cisco MetroPlanner, refer to Chapter 1, “Overview.”

Manage the Cisco MetroPlanner Window

The Cisco MetroPlanner window provides a menu bar, toolbar, a Project Explorer pane, a Properties
pane, an Analyzer pane, and a Task Pane to allow you to manage a network design (Figure A-1). The
Networks Mgmt Tree tab displays the networks that you have created for a project. The NtVw Net# tab
displ